I. Getting Started

Setting up the User Profile

Enter the User Code and Password assigned to you by Client Services. If your computer is connected to a Windows-based quote service, click on the Quote Service button to enter the parameters for the DDE application. Please contact Client Services at 800-419-6632 for instructions on setting up this option.

- The IP Address and Backup IP will already contain the necessary information (wondacharts.williamoneil.com).
- The Multiple Monitor Set-up is used only if monitors are placed vertically with WONDA running on all monitors.
- The Work Offline box should not be checked. This option is only selected when using the WONDA Application without connecting to the host in Los Angeles. This is often done when traveling. If the WONDA software is loaded on a notebook PC and the Work Offline option is selected, graphics that have been archived can be viewed without connecting to the host. For detailed instructions on using the Archive Function, please see Section II.
- The Frame Relay/DNS Clients is used when alpha addresses are used instead of numeric addresses.
- Use SSL (Secure Sockets Layer), is a protocol developed for transmitting private documents via the Internet. SSL works by using a private key to encrypt data that’s transferred over the SSL Connection. The following features use SSL; Data Monitor, Portfolios, Custom Screen Reports, User Profiles, Transactions and Notes.
- Proxy settings are defaulted to “Use Default User Settings”, however if the network configuration requires specific proxy information the user or tech can insert the information in this window.

Please contact Client Services at 800-419-6632 or support@williamoneil.com for instructions on setting up any of the options in the User Profile.

This section’s purpose is to provide step-by-step examples to get you started using WONDA. Please refer to the index in the back of this manual for more detailed descriptions of specific features.
Starting WONDA

To access WONDA double click on the WONDA icon located on the desktop. Or, the user can select the Start button, highlight Programs, select the WONDA group and click on WONDA.

Accessing a Graph

To view a graph, follow these steps:

1. Enter the symbol of an issue in the Symbol field.

2. Click on the Daily, Weekly, Monthly or Intraday button to view a graph.
The following is an example of a Daily graph. For detailed information on daily graphs, please see Section II.

Accessing the O'Neil Industry Groups

Viewing a graph of The William O'Neil + Co. 197 Industry Groups® can be done as follows:

1. Graphing a stock and clicking on the name of the O'Neil Industry Group link which appears in blue font on Daily, Weekly and Monthly graphs.
Section I: Getting Started

The specific Industry Group graph will appear.

2. To view the list of stocks comprising the index, click on the O'Neil Industry Group link again. A window (shown below) will appear containing a list of all stocks within the group. The O'Neil Industry Group index is displayed at the beginning of the list. This list can also be displayed by right-clicking on the name of the industry group when a stock is graphed. To view all of the O'Neil Industry Groups, click on the blue Group Rank link (circled above).
3. The O'Neil Industry Group list can also be accessed by clicking on the Data button and then selecting the O'Neil Industry Group listed in the Data menu.

For detailed information regarding the O'Neil Industry Groups, please see Section II.

Once the list of component stocks has been opened, the user has a variety of options available. These List Box options are discussed next.
List Feature Options

- **Maximizing the List** - To maximize the list, click on the maximize icon, which will enlarge the list to fit the entire screen.

- **Copy the List to a Portfolio** – Using the Alt key on the keyboard and clicking and dragging, the list may be copied into a Portfolio using the Portfolio function. For detailed instructions on copying lists to Portfolios, please see Section II.

- **Export the List to Microsoft® Excel®** - The list may be exported to Excel by selecting the icon.

- **Screening on the List** - This feature allows the user to filter through any list using the Custom Screen function. By either using an existing custom screen or creating a new custom screen, the user may filter out stocks from these lists that do not meet the desired criteria.

1. **Creating a New Custom Screen to Run on the List** – The user may create a new custom screen to filter through a list of stocks. For detailed instructions on creating Custom Screens, please see Section IV.

2. **Running an Existing Custom Screen on the List** - To run a screen against a list of stocks, locate the desired screen in the yellow Screen List drop down window and highlight it so that the screen name appears in box as shown. Select the Run button located to the left of the screen list and the chosen custom screen will be applied to the stocks contained in the user’s list. When the custom screen is finished, a box will appear stating how many stocks were selected. Click on the Get Report button and the selected stocks will appear in a new list box. For detailed instructions on creating Custom Screens, please see Section IV.
Remember that the list being screened upon contains a limited number of stocks. The additional criteria should be broad enough so that the list is not reduced to zero stocks. An example would be to use the Performance List NYSE Up In Price (found under Lists, Performance Lists), and create a Custom Screen that contains:

- **MKTVAL GTR 500M** (Market Value > $500,000,000)
- **AVDOLV GTR 50M** (Volume, Average Daily Dollar Volume > $50,000,000)

3. **Open or Edit an Existing Custom Screen** – To open an existing Custom Screen, select the custom screen in the yellow Screen List drop down window. Select the Open button located to the right of the Screen List to open and view the Custom Screen and view the set criteria. Criteria may be deleted or added while the Custom Screen is open. Once the changes have been made, select the OK button at the bottom of the Selection Criteria or Report tabs to save the changes. Click on the Run button to process the Custom Screen.

- **Printing the List** - The list may be printed by selecting the printer icon in the list window. To print an individual graph, double click on any stock to display the graph. Select the Print option located in the File menu. To print out all graphs from a list, select the Print box within the list window and select the Play button. The user may select Print Track Price located in the File menu, which will display the data blocks along with a graph. For detailed instructions on operating the Auto Call feature, please see Section III.

**NOTE:** The Fundamental and Earnings blocks will print out only with a Standard Weekly graph. The Annual block will print out only with a Standard Monthly graph.

- **Printing Multiple Graphs on a Page** - To print up to four graphs on one page select the Windows menu feature and select New Window (open up to four Graph windows). In the list box, select the Print box, the Multi Graph box and click the Play Button.

**Note:** If the user tries to print two or three graphs per page, the formatting will remain four graphs per page.

- **Sorting the List** - Clicking on any of the column headings in the list box will sort the stocks by that column in ascending order. The column heading of the current sort appears in blue font. Click the heading a second time to sort in descending order.

**NOTE:** By holding down the Shift key when sorting by a column heading, the sort will be descending. By holding down the Control key when sorting by a column heading, that heading will become the secondary sort.
• **Moving the List Items** - To move a heading and its corresponding data, click, drag and drop the column heading on top of another heading. Once the mouse button is released, the heading will be placed to the left of where it was dropped. The headings and data will be rearranged accordingly.

• **Viewing Graphs from the List** - There are three ways to view the companies in the list:

  1. Double click on any name will bring up the current company graph. To change the graph timeline click on the following graph buttons with the mouse or use the Function keys:

      ![Graph Buttons]

  2. To scroll through the whole list using the Play Mode feature, highlight the first stock to be viewed and click the play icon at the bottom of the list. Graphs of the stocks in the user’s list will display in successive order.

     To change the type of graph displayed, select the Daily, Weekly, Monthly or Intraday button anytime during this procedure.

     Once in Play Mode, Pause and Stop option buttons will be activated on the Browser toolbar.

     **NOTE:** In Play Mode, the delay between graphs is defaulted to six seconds. This may be changed by accessing Settings, Graphic Options, and viewing the Play Options feature.

     To study a particular graph in more detail, click the pause button to pause the cycle. To resume playing the remainder of the securities in the list, click on the Pause button again.

     Press the Stop button to exit or discontinue graphing the securities at any time. Alternatively, users can click on the space bar or click on any part of the WONDA graph to exit Play Mode.

  3. Users may also scroll through any list by highlighting (double-clicking) the first stock in the list, and pressing the space bar for each new graph.

**Using the Search Function**

The O'Neil stock symbols, especially in the case of foreign or regional stock exchanges, may differ from other databases. You can verify and locate stock symbols using the Search Feature.

To use the Search function, follow these steps:

1. Type a forward slash (/) or click on the magnifying glass icon. The Search feature can also be located under the Tools button.
2. Once the Search window appears, a company name and stock symbol can be found by typing part or the entire company name in the entry field. A list of names and the corresponding stock symbols are displayed in the Search window.
3. View a graph a particular company by double-clicking on the company name. Use the left << and right >> buttons to view additional companies.

4. Click on the X button to exit this function.

**Favorites**

Favorites is designed to provide a simple way to access frequently viewed features such as Custom Screens and Macros, Portfolios, Data Monitors, and other lists.

To add a new list, Data Monitor, Macro or Portfolio to Favorites, open the window associated with the feature and click on the Add to Favorite button at the bottom of the window.

Custom Screens can be added to Favorites by Selecting the Add to Favorite button at the bottom of the Run Custom Screen window.

**Using the Favorites Icon**

To view any stored Favorites, click on Favorites icon located on the top toolbar. This will open the Favorites window.

Select a list, Portfolio, Macro or Data Monitor to view and click on the Open button or double-click on the name of the favorite. Selecting a Custom Screen from the Favorites window will automatically run the screen and produce the report.
Deleting Favorites

To delete any item from Favorites, highlight it in the Favorites window and click the Delete from Favorite button located at the bottom of the window. A message will appear confirming the deletion.

Comparisons Graphs

This feature allows a user to compare two or more stocks, indices, commodities, mutual funds, portfolios, or industry groups over a period of time. To plot a Comparisons graph, click on Graph Type menu and select the Comparisons option. Select one of the following options:

One Year (Daily)—displays 260 days of performance.

Five Years (Weekly)—displays 260 weeks of performance.

Twenty Years (Monthly)—displays 260 months of performance.

This will open a new Comparison window. This new window will copy whatever symbol appeared on the previous graph window and display it in the symbol box. To view the performance of this symbol, click on the Add button or press Enter on the keyboard. To view additional stocks on the same Comparisons graph, enter the desired symbol and click on the Add button (or use the Enter key).

The upper-left hand corner of the Comparison charts displays a table that summarizes each of the returns. The index starts at 100 and plots the graph according to its percentage increase/decrease over
the determined time period. The graph will not plot below zero.

The beginning and ending dates of the Comparison graph are displayed in the upper right-hand corner. You may change these dates by using the Start and End fields and clicking on the Apply button. For more information about Comparisons, see Section III.

Toolbar Features and Options

By default, WONDA provides the above toolbar icons above the graph. However, the user has the option to add or delete icons. Note: To reposition any toolbar, click on the left edge of the toolbar and drag it to the desired location. To return all toolbars to their original location, go to the Windows Menu and select Reposition Toolbars. The following toolbars reflect the default settings.

Adding/Deleting Icons

Adding/Deleting Icon Categories

By right-clicking on the toolbar area, the user can choose which icon categories to display. The user can also add or delete icon categories by going to Settings menu, Graphic Options, Toolbars. Categories include Stock Data, Notes, Graphic Options, Browser, Company Name, Country, and Currency.

Adding/Deleting Individual Icons

The user also has the option to add/delete individual icons by clicking on Settings menu, Graphic Options, Toolbars. Click on the toolbar category from which you want to add items. Once highlighted, click on Customize.

A new window will appear which will allow the user to choose the icons located in the toolbar.
Items not yet displayed in the toolbar are located on the left hand side. Items currently in the user’s toolbar are on the right hand side. To add a toolbar icon, highlight the icon on the left hand side and click add. To delete an item already listed in the user’s toolbar, highlight the icon on the right hand side and click remove. Using the two drop down menus, the user has the option to list the icon name next to the icon, change the icon size, or change the order the icons are displayed.

Resetting Icons to Display the Default Icons

To reset the user’s icon toolbar to reflect the icons only listed by default, go to Settings, Graphic Options, Toolbars. Highlight an icon category and click reset. The icons in the highlighted category will revert back to the default settings.

Viewable Icons

Stock Data
Section I: Getting Started

Additional Stock Data

- Company News
- Condensed Balance Sheet
- Condensed Income Statement
- Financial Ratios
- SEC Edgar Filings
- Thomson Equity Strategies
- Index Membership

Notes

- Enable/disable Notes and Transactions
- Down Arrow
- Square
- Arc
- Text Box
- Delete All Notes
- Transaction Reports List Box
- Record Transactions
Graphic Options

Additional Graphic Options

Browser
To search by company name, start typing in the Company Name toolbar as shown above. Once the company name is typed, click Enter on the keyboard to search for the company. Double-click on the chosen name to pull up a graph.

The magnifying glass tool allows the user to search a security or ticker symbol using a keyword search. Clicking on the icon pulls up a new window.

Choose the specified country to search from (defaulted search to “all” countries) as well as the instrument (stock, mutual fund or index). By typing keywords into the search section, the list of companies will decrease according to what the user types in.

To search companies located to a specific country, locate the icon shown above. Click on the country you wish to view. When using the Company Name search tool along with the Country tool, the user can
limit their search to a specific country.

**Note:** Country identifiers in The O'Neil Database® may be different from other sources. To search for a ticker symbol, use the search tool.

**Currency**

The user has the option to display the graph in different currencies. The default currency shown will be the default currency for the stock's country. By clicking on the drop down tab, the user can choose an alternative currency in which to display the graph and data.
This page intentionally left blank.
II. Graph Sub Menu

The sub-menu buttons shown below are available on the graph screen. The buttons can be accessed either by mouse or by using the left and right arrow keys. Pressing Enter on the keyboard or clicking the mouse will activate the selection. Additionally, the F1 through F8 keys are associated with the gray graph sub-menu buttons. F1 will display the Data Menu, F2 will call a Daily Graph, and so forth. F10 will open the Fundamental Block and F11 will open the Earnings Block.

<table>
<thead>
<tr>
<th></th>
<th>Data</th>
<th>Daily</th>
<th>Weekly</th>
<th>Monthly</th>
<th>Intraday</th>
<th>Market</th>
<th>Lists</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Symbol Field

Enter the symbol of the issue in the blue symbol field. The cursor will default to this field when the main window is the active window.

NOTE: The O'Neil Stock symbols, especially in the case of foreign or regional exchange stocks, may differ from symbols in other databases. To verify a symbol, use the Search function. For detailed instructions on using Search, please see Section I.
Data

This selection will display the Fundamental Block, Company News, Earnings Block, Sponsorship Block, CEO Profile, Sponsorship, Index Membership, Custom Data Block, Custom Data Report, Top 25 Morningstar Fund Owners, and the Industry Group for the current company graphed.

Fundamental Block

This selection will display the data block in the top section of the WONDA Graph. The Fundamental Block can be printed on a weekly graph. **Fundamental and Earnings blocks only print with weekly and monthly graphs in order to match the financial timeline with the price and volume timeline.** For a detailed description of each data item, please refer to Section II, Appendix A.

Company News

This selection will display the company news items which may have an effect on the company’s stock price. These news items are input by William O’Neil’s internal Data Research department.
Earnings Block

This selection will display the earnings information in the bottom section of the WONDA Graph. The earnings per share data is updated hourly. The months displayed on the bottom of the Earnings Block can be changed from calendar to fiscal by right-clicking with the mouse on the Earnings Block and selecting Fiscal. The Earnings Block can be printed on a weekly graph. **Fundamental and Earnings blocks only print with weekly and monthly graphs in order to match the financial timeline with the price and volume timeline.** For a detailed description of each data item, please refer to Section II, Appendix B.

Sponsorship Block

This section provides information about Mutual Funds' holdings of the stock currently graphed. When pulling up the Sponsorship Block, the Leading Growth Funds (14 default funds) are listed along with their assets under management, turnover percentage and number of stocks. Holdings information is displayed, which shows the Fund’s Holdings Rank of the current stock on a 1-99 scale. Higher numbers represent greater dollar value relative to the entire fund portfolio.

To create a list of different funds when viewing the Sponsorship Block, click on the magnifying glass displayed in the first row of the Sponsorship Block. The Search screen will appear. Click on the Create New List icon located in the bottom left corner of the screen to create a new list. After naming the new list, search for mutual funds in the search toolbar on the top of the screen. The user has the ability to search by certain Sponsor Type as well as Sponsor Style. Once the chosen fund is found, click and hold the fund and drag it down to the Sponsorship Block section to add it to the list. When opening the Sponsorship Block, the new list should appear in the Leading Growth Funds drop down menu bar.

CEO Profile

This selection will display specific information on CEOs. It includes vital statistics on the company's current CEO. This information may be printed by selecting Print from the File menu.

Sponsorship

Accessing holdings information on a particular stock can be accomplished by selecting the Sponsorship option under the Data button. Sponsorship information includes the number of shares held by Mutual Funds, Advisors, Banks and Other. The ownership is sorted by position - new positions (N), increased positions (+), unchanged positions, decreased positions (-). Positions updated a quarter previous to the listed date include an asterisk (*) in front of the name. If available, a letter grade based on a mutual fund's 36-month moving average of total return is provided in the Rank column. **The timeliness of the sponsorship information will depend on how often the particular institutions and mutual funds report their holdings.**
Section II: Graph Sub Menu

Also available, is a list of holdings of a particular institution or mutual fund contained in the Sponsorship list. Once the Sponsorship window is open, clicking on a name with the mouse will produce a list of the selected institution’s holdings.

The list can be resorted using the column headings in the window. The list of the institutions’ holdings can also be accessed by clicking on the Sponsorship tab in the Search feature found under the Tools button. The list of holdings under each category may be printed by selecting the printer icon.

Another way of accessing a mutual fund holdings list is by pulling up a daily, weekly or monthly NAV mutual fund graph and then selecting the corresponding name under the Data button. If you do not know the symbol of a mutual fund, you can retrieve the graph by typing in the mutual fund’s name through the Search feature under the Tools button. For detailed instructions on using Mutual Fund Search, please see Section I.
Thomson First Call® Earnings Estimate Reports

If you receive the Thomson First Call® entitlement for Research Direct there is a simple way to view any reports released in the past 24 hours for these two products. Click on the Data button and select the Thomson First Call® Reports option. The window pictured below will appear on the lower left hand side of the WONDAgraph. To view a report, click on the heading. To access Thomson First Call® Research Direct and/or Broker Detail Reports products you will need authorization from Thomson Reuters. Client Services can assist by contacting Thomson Reuters or if you have a Thomson Reuters Representative they can assist with this authorization.

Index Membership

This option pulls up a window listing all the indices that contain the current stock. To graph the index listed in the Index Membership window click on the name in the window.

Custom Data Block

This option allows users to display the previously run custom data block. Custom Data Blocks allow the user to retrieve data using our Custom Screen dictionary and can be linked to pull when graphs are requested. For detailed information on Custom Data Blocks, please see Section V.
Custom Data Report

This option allows users to display the previously run Custom Data Report. Custom Data Reports are customized reports that may contain multiple custom data blocks. For detailed information on Custom Data Blocks, please see Section V.

Top 25 Morningstar® Fund Owners

This section provides information relating to the Funds holding the stock currently graphed. The information includes fund, fund symbol, % of assets, shares held, change from prior period, ranks vs. all funds on a 3 year basis, rank in category on a 3 year basis, objective as well as holdings date.

Industry Groups

This selection will display a list of the stocks in the same O'Neil Industry Group as the stock graphed (sorted from highest to lowest market value).
Daily

This selection will retrieve a daily arithmetic or logarithmic graph. By right-clicking with the mouse on the Daily button, the Monthly, Quarterly, Semi Annual, Annual, Standard, Extended, Arithmetic or Logarithmic option can be selected. The amount of data displayed on the screen will vary depending on the resolution of each monitor. By default, the graph contains the price and volume on a daily basis. Also supplied, is a 50-day moving average price line, a relative strength line versus the S&P 500 Index, the relative strength numerical value, the Accumulation/Distribution Rating and a 50-day average daily volume line. The current price with the point change from the previous day’s close and volume appear in the upper left hand corner of the graph. These quotes are updated every ten minutes on a 20-minute delayed basis. If the user has a DDE interface to a quote service, graphs may be set up to update dynamically on a real-time basis. Real-time prices from the DDE will only be pulled into WONDA during market hours. The OH (Off High) and Rate are also displayed in the upper left hand corner of the graph. The OH is the percentage change between the current closing price and the 52-week high. The Rate measures a stock’s current day’s trading activity in relation to its average trading activity. The day’s trading activity is broken into time segments to measure this. For example, if the 50-day average volume for a security is 3,436,200 shares and the current day’s trading volume is 3,642,300 shares after 3.25 hours of trading, the rate would be 112% above the average daily volume at that time in the trading day.

The Rate is calculated as follows:
3.25 hours = 50% of the total trading day
50% of the average daily volume (3,436,200) = 1,718,100
\[ \Delta \% \text{ between actual volume of 3,642,300 and 1,718,100} = 112\% \]

Rate = 112%

In addition, a New Issue flag appears displaying the date the company started trading as well as its new issue price. The New Issue flag will appear if the company’s first trading date is within the time frame graphed. If the company recently reorganized, a Restructure Flag will appear on the graph. The bottom left displays the date the company went public.
Weekly

This selection will retrieve a weekly logarithmic or arithmetic graph that contains the price and volume on a weekly basis. By right-clicking with the mouse on the Weekly button, the One Year, Three Years, Standard, Logarithmic or Arithmetic option may be selected. By default, the graph contains a 200-day moving average line, a relative strength line versus the S&P 500 Index, the relative strength numerical value, Accumulation/Distribution Rating, and a ten-week average volume line. The weekly graph plots an earnings per share line on a running 12-month basis and displays each company’s high based on the data graphed, marked by an arrow to the right of the price scale. Corporate events are also available on the weekly graph. The current price with the point change from the previous week’s close and volume appear in the upper right hand corner of the graph. These quotes are updated every ten minutes on a 20-minute delayed basis. The OH (Off High) and Rate are also displayed in the upper right hand corner of the graph. OH represents the percentage change between the current closing price and the high within the last 52-week period. The Rate measures a stock’s current week’s trading activity in relation to its average trading activity. The week’s trading activity is broken into time segments to measure this. For example, if the ten-week average volume for a security is 71,683,700 shares and the current week’s trading volume is 38,925,000 shares after two days and two hours of trading, the rate would be 18% above the average daily volume at that time in the trading day.

The Rate is calculated as follows:
2 full trading days (13 hours) + 2 hours = 15 hours / 32.5 = 46.2% of the week
46.2% of the 10-week average volume (71,683,700) = 33,117,869
Δ% between actual volume of 38,925,000 and 33,117,869 = 17.5%

Rate = 18%
Monthly

This selection will retrieve a logarithmic monthly graph. By right-clicking on the Monthly button, Standard or Extended maybe selected. The graph shows the price and volume on a monthly basis. By default the graph contains a six-month moving average price line, a relative strength line versus the S&P 500 Index, the earnings per share line on a running 12-month basis, the relative strength numerical value, the Accumulation/Distribution Rating and a 6-month average volume line. The current price with the point change from the previous month’s close and volume appear in the upper right hand corner of the graph. These quotes are updated every ten minutes on a 20-minute delayed basis. The OH (Off High) is displayed in the upper right hand corner of the graph and it is the percentage change between the current closing price and the high within the last 12 month period.
Intraday Graph

This selection will retrieve an arithmetic Intraday graph. Prices shown are the high, low and last of all transactions that occurred during the time interval. The graph displays price and volume data. The current price appears in the upper left-hand corner of the graph with the time stamp of the most recent quote; these quotes are updated every ten minutes on a 20-minute delayed basis. By right-clicking with the mouse on the Intraday button, a user may select a one-minute, five-minute, ten-minute, 15-minute, 30-minute or 60-minute graph interval. Over 30 days of data can be displayed. Graphs can be viewed as a Line Graph by clicking on the Line Graph option.

Company Information Bar

Located at the top of the graph, from left to right, is the name of the security, symbol, exchange, the company's industry group, current market capitalization (if the company has several classes of stock the market capitalization of all shares are shown in parentheses), trailing four-quarters sales for the company, shares (if the company has several classes of stock the combined shares are shown in parentheses), current float of the primary class, and the next estimated earnings report date.

The industry group graph can be viewed by clicking on the industry group name listed on the Company Information Bar.
Once the industry group graph is selected, clicking on the industry group name will display a list of the stocks that comprise that industry group.

Market
Selecting the Market button provides access to the O'Neil Industry Groups, Industry Group Performance Lists, Market Indices, Market Index Components, Russell Indices (only with the Russell Entitlement), Market Indicators, Current Articles and Economic Indicators.
O'Neil Industry Groups

This selection provides access to the list of the 197 O'Neil Industry Groups. Included in the list is select data for each industry group. The current index value is updated every ten minutes.

Additionally, a list of all the stocks in a group can be viewed by selecting the Data button while an industry group is graphed. Select the name of the group that appears at the bottom of the Data menu. A window containing all the stocks in the group will open.

Industry Group Performance Lists

This selection allows the user to view daily lists of securities meeting specific criteria. The lists are based on The William O'Neil + Co. 197 Industry Groups. The following lists are available:

- **Bottom 10 Groups with Most New Lows (% Defensive)**
  Industry Groups with the lowest percentage of new highs in the group (intraday). Industry groups that are defensive groups will have an asterisk next to the industry group name and the percentage of those groups that are defensive are indicated on the bottom of the list. For example, if two industry groups are defensive the percentage will be 20 percent.

- **Ind Groups Reaching 52 Wk High (IntraDay)**
  Industry groups reaching a new 52-week high on an intraday basis.

- **Ind Groups Reaching 52 Wk High (PriorDay)**
  Industry groups reaching a new 52-week high on the prior day.

- **Ind Groups Reaching 52 Wk Low (IntraDay)**
  Industry groups reaching a new 52-week low on an intraday basis.

- **Ind Groups Reaching 52 Wk Low (PriorDay)**
  Industry groups reaching a new 52-week low on the prior day.
Industry Performance List*
All 197 O'Neil Industry Groups are presented in this list to give the user the capability of sorting by percentage changes. This list contains many report items including Group Rank and percentage changes that can be used to find important and useful Industry Group information.

Number of New Highs by Ind (IntraDay)*
Number of stocks reaching a new 52-week high. The list covers all NYSE and AMEX common issues and all NASDAQ common issues over $2. It is sorted by volume percent change within each industry group.

Number of New Highs by Ind (PriorDay)
Number of stocks reaching a new 52-week high. The list covers all NYSE and AMEX common issues and all NASDAQ common issues over $2. It is sorted by volume percent change within each industry group. The list is based on the previous day’s data.

Number of New Lows by Ind (IntraDay)*
Number of stocks reaching a new 52-week low. The list covers all NYSE and AMEX common issues and all NASDAQ common issues over $2. It is sorted by volume percent change within each industry group.

Number of New Lows by Ind (PriorDay)
Number of stocks reaching a new 52-week low. The list covers all NYSE and AMEX common issues and all NASDAQ common issues over $2. It is sorted by volume percent change within each industry group. The list is based on the previous day’s data.

Percent of New Highs by Ind (IntraDay)*
Percent of stocks reaching a new 52-week high. The list covers all NYSE and AMEX common issues and all NASDAQ common issues over $2. It is sorted by volume percent change within each industry group.

Percent of New Highs by Ind (PriorDay)
Percent of stocks reaching a new 52-week high. The list covers all NYSE and AMEX common issues and all NASDAQ common issues over $2. It is sorted by volume percent change within each industry group. The list is based on the previous day’s data.

Percent of New Lows by Ind (IntraDay)*
Percent of stocks reaching a new 52-week low. The list covers all NYSE and AMEX common issues and all NASDAQ common issues over $2. It is sorted by volume percent change within each industry group.

Percent of New Lows by Ind (PriorDay)
Percent of stocks reaching a new 52-week low. The list covers all NYSE and AMEX common issues and all NASDAQ common issues over $2. It is sorted by volume percent change within each industry group. The list is based on the previous day’s data.

Top 10 Groups with Most New Highs (% Defensive)
Industry Groups with the highest percentage of new highs in the group (intraday). Industry groups that are defensive groups will have an asterisk next to the industry group name and the percentage of those groups that are defensive are indicated on the bottom of the list. For example, if two industry groups are defensive the percentage will be 20 percent.

*Based on 15 minute delayed pricing.
Market Indices

This selection provides access to the O'Neil Market Indices Data. Included in the list is select data for each index. Double click on the index to view the graph.

To view the description of the market index, click on Index Description under the Data button. A window will appear which contains the description of the index.

Market Index Components

This section enables users to view lists of securities which comprise many of the standard indices.

Access to the Russell index components is not part of the base WONDA package and requires an entitlement. If you are a current Russell Index client, please contact your Russell contact directly or sales executive. If you are not a Russell Index client, please contact Client Services at (800) 419-6632 for more information.

Russell Indices

This feature provides access to all proprietary Russell indices including both price-weighted and total return indices. Index values are available both graphically and in tabular form. To access these indices, click on the Market button and select Russell Indices. A window will display all indices and the index values as well as the percent change over various time periods. Custom Screens may also be used to filter on the components of each index.
Market Indicators

This selection will provide access to various data on the New York Stock Exchange, AMEX and NASDAQ markets. Graphs showing the percent of stocks above their 150-day moving average are available for the NASDAQ and NYSE markets. Also, there are market graphs which provide daily summaries of Puts versus Calls Trading Ratios, Percentage of Investment Advisors Bullish versus Bearish and a Short Term Overbought - Oversold Oscillator and ten-day moving average graphs for new highs and new lows.

Current Articles

This selection allows the user to obtain a trailing 12-week list of available Investors Business Daily newspaper articles. The list contains the symbol, company name, industry name, article date, source, article title, article number and page number. Double-clicking on an article will open it for viewing.

Economic Indicators

This feature allows the user to graph economic data. The feature is subdivided into five different categories:

- Economic Calendar
- General Economic Data
- Commodities
- Key Currencies
- Treasuries
Lists

This menu will provide access to various lists.

Alerts

The Alerts feature allows the user to monitor stock activity by placing upper and lower price limits on specific stocks or drawing a trend line on a graph. You can also set an alert when a stock crosses one of its moving average lines. These Alerts can be set to signal a stock’s tick up or down to a certain price and can be placed on Daily, Weekly and Monthly Graphs. To create or adjust a price alert, enable the Line Pen option from the Tools menu and draw a trend line directly on the graph to correspond with your price target. Then, bring the cursor to the newly drawn trend line and it will turn into a hand. Click the left mouse button and a message will appear asking if the alert should be set. As an alternative, after drawing the trend line, click on the Tools button and choose Add line to Alerts.
Price Alerts can also be created by calling Alerts from the Lists menu. This window will display the stocks with previously created price targets and their current prices. Once this window is activated, click on the Add button to add the stock that is graphed. The stock is then added to the Alerts window and data will then fill in for the % to Upside and % to Downside as the price updates. The default sort is the % to Upside and is automatically refreshed.

To adjust price limits for the stock, right-click on the stock symbol and advance to the desired tab. Enter the target price in the Current price field or High/Low alert limit field and click Set. To reactivate an alert, right-click on the stock, select the tab of the alert to be reactivated and click on the Set button.

In order for an alert message to display in a pop-up box, click on the Options button in the Alerts window and check Enable Popup box. When Enable Sound is checked, a chime will accompany the pop-up message. To keep the Alerts feature always active, the Alerts Always On must be checked. When this is active, closing the Alerts window will not prevent an alert from popping up when a stock has crossed an alert line.

Alerts are updated every 15 minutes with delayed pricing and you can have up to 300 stocks in the alert list. With a DDE quote service linked into WONDA there can be up to 1000 stocks set in the alerts list.

**Performance Lists**

This selection allows the user to view daily lists of securities meeting specific criteria. These lists are updated on a 15 minute delayed basis. The following lists are available:
50 Day Mvg Avg Cross Above 200*
Stocks with their 50-day moving average values crossing above their 200-day moving average values on an intra-day basis. This list includes all exchanges and is sorted by volume percent change.

50 Day Mvg Avg Cross Below 200*
Stocks with their 50-day moving average values crossing below their 200-day moving average values on an intra-day basis. This list includes all exchanges and is sorted by volume percent change.

85 or Greater EPS Rank
Stocks with EPS Rank values of at least 85. All stocks are greater than or equal to $5. This list is sorted by EPS Rank.

85 or Greater Relative Strength
Stocks with Relative Strength values of at least 85. All stocks are greater than or equal to $5. This list is sorted by Relative Strength.

AMEX Above 150 Day Moving Average
Stocks with the current day's price above the 150-day moving average. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percentage change.

AMEX Down in Price
Stocks with the current day's price percent change down at least three percent from the previous day's close. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percent change.

AMEX Down on Volume
Stocks with a current day's price down at least a 1/4 of a point from the previous day's close and a current volume percent change of at least 20 percent. All stocks are over $5, have an average daily volume of at least 10,000 shares or more and a market capitalization of at least $25,000,000. This list is sorted by volume percent change.

AMEX New Highs
Stocks with the current day's high price greater than the 52-week high price. All stocks are considered and sorted by price percent change.

AMEX New Lows
Stocks with the current day's low price less than the 52-week low price. All stocks are considered and sorted by price percent change.

AMEX Short Interest Report**
Provides the total short volume and the number of days to cover short interest based on the average daily volume for 100 stocks. The number of days to cover short interest is provided for each of the last three periods. This list is sorted by the number of days to cover short interest for the most recent period.

AMEX Up in Price
Stocks with the current day's price percent change up at least three percent from the previous day's close. All stocks are over $5, have an average daily volume of 10,000 and a market capitalization of $25,000,000 or more. This list is sorted by price percent change.

AMEX Up on Volume
Stocks with the current volume percent change of at least 20 percent and the current day's price up 1/4 of a point or more. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by volume percent. 
change.

**Combined Above 150 Day Moving Average**
Stocks with the current day’s price above the 150-day moving average. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list includes AMEX, NASDAQ and NYSE exchanges and is sorted by price percentage change.

**Combined Down in Price**
Stocks with the current day’s price percent change down at least three percent from the previous day’s close. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list includes AMEX, NASDAQ and NYSE exchanges and is sorted by price percent change.

**Combined Down on Volume**
Stocks with a current day's price down at least a 1/4 of a point from the previous day's close and a current volume percent change of at least 20 percent. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list includes AMEX, NASDAQ and NYSE exchanges and is sorted by volume percent change.

**Combined New Highs**
Stocks with the current day’s high price greater than the 52-week high price. This list includes AMEX, NASDAQ and NYSE exchanges and is sorted by price percent change.

**Combined New Lows**
Stocks with the current day's low price less than the 52-week low price. This list includes AMEX, NASDAQ and NYSE exchanges and is sorted by price percent change.

**Combined Up in Price**
Stocks with the current day's price percent change up at least three percent from the previous day's close. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list includes AMEX, NASDAQ and NYSE exchanges and is sorted by price percent change.

**Combined Up on Volume**
Stocks with the current volume percent change of at least 20 percent and the current day's price up 1/4 of a point or more. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list includes AMEX, NASDAQ and NYSE exchanges and is sorted by volume percent change.

**Earnings News (Best Ups)**
Stocks shown are over $8 and are up 30 percent or more versus the comparable quarter last year and five percent or more versus the previous quarter. This list is sorted by percent change in trailing four quarters’ earnings versus the same quarters’ prior year earnings.

**Earnings News (Most Downs)**
Stocks shown are over $8 and are down 50 percent or more versus the comparable quarter last year. This list is sorted by percent change in trailing four quarters’ earnings versus same quarters’ prior year earnings.

**Fastest Growing Companies**
Lists the top 100 companies traded on NYSE, AMEX or OTC according to their five-year earnings growth rate. This list is sorted by growth rate.
NASDAQ Above 150 Day Moving Average
Stocks with the current day's price above the 150-day moving average. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percentage change.

NASDAQ Down in Price
Stocks with the current day's price percent change down at least three percent from the previous day's close. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percent change.

NASDAQ Down on Volume
Stocks with a current day's price down at least a 1/4 of a point from the previous day's close and a current volume percent change of at least 20 percent. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by volume percent change.

NASDAQ New Highs
Stocks with the current day's high price greater than the 52-week high price. All stocks are considered and sorted by price percent change.

NASDAQ New Lows
Stocks with the current day's low price less than the 52-week low price. All stocks are considered and sorted by price percent change.

NASDAQ Short Interest Report**
Provides the total short volume and the number of days to cover short interest based on the average daily volume for 100 stocks. The number of days to cover short interest is provided for each of the last three periods. This list is sorted by the number of days to cover short interest for the most recent period.

NASDAQ Up in Price
Stocks with the current day's price percent change up at least three percent from the previous day's close. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percent change.

NASDAQ Up on Volume
Stocks with the current volume percent change of at least 20 percent and the current day's price up 1/4 of a point or more. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by volume percent change.

NYSE Above 150 Day Moving Average
Stocks with the current day's price above the 150 day moving average. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percent change.

NYSE Down in Price
Stocks with the current day's price percent change down at least three percent from the previous day's close. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percent change.

NYSE Down on Volume
Stocks with a current day's price down at least a 1/4 of a point from the previous day's close and a current volume percent change of at least 20 percent. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of at least $25,000,000 or more. This list is
sorted by volume percent change.

**NYSE New Highs**
Stocks with the current day's high price greater than the 52-week high price. All stocks are considered and sorted by price percent change.

**NYSE New Lows**
Stocks with the current day's low price less than the 52-week low price. All stocks are considered and sorted by price percent change.

**NYSE Short Interest Report**
Provides the total short volume and the number of days to cover short interest based on the average daily volume for 100 stocks. The number of days to cover short interest is provided for each of the last three periods. This list is sorted by the number of days to cover short interest for the most recent period.

**NYSE Up in Price**
Stocks with the current day's price percent change up at least three percent from the previous day's close. All stocks are over $5, have an average daily volume of 10,000 and a market capitalization of $25,000,000 or more. The stocks are sorted in order of greatest price percent change.

**NYSE Up on Volume**
Stocks with the current volume percent change of at least 20 percent and the current day's price up 1/4 of a point or more. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by volume percent change.

**Price Hits New 5 Year High**
Stocks with intra-day high greater than it's prior five-year high. The list includes stocks from all exchanges and is sorted by price percent change.

**Price Moves Above 200-Day Moving Average**
Stocks with current day's price above the 200-day moving average price. The list includes stocks from all exchanges that are $5 and over and is sorted by price percent change.

**Price Moves Above 50-Day Moving Average**
Stocks with current day's price above the 50-day moving average price. The list includes stocks from all exchanges that are $5 and over and is sorted by price percent change.

**Price Moves Below 200-Day Moving Average**
Stocks with current day's price below the 200-day moving average price. The list includes stocks from all exchanges that are $5 and over and is sorted by price percent change.

**Price Moves Below 50-Day Moving Average**
Stocks with current day's price below the 50-day moving average price. The list includes stocks from all exchanges that are $5 and over and is sorted by price percent change.

**Relative Strength and EPS Rank Above 85**
Stocks with Relative Strength and EPS Rank values of at least 85. All stocks are over $5 and are sorted by price change.

**Stocks Gapping Down in Price**
Stocks with the current volume greater than the average daily volume and the current day's price down more than a 1/4 of a point from the previous day's low. All stocks are over $5, have an average daily...
volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percent change.

**Stocks Gapping Up in Price**
Stocks with the current volume greater than the average daily volume and the current day's price up more than a 1/4 of a point from the previous day's high. All stocks are over $5, have an average daily volume of at least 10,000 shares and a market capitalization of $25,000,000 or more. This list is sorted by price percent change.

**Top 250 DG Over 500 Mil**
The 250 stocks with the highest Datagraph Rating that have a market cap of at least $500 million. These stocks are traded on the NYSE or AMEX and are sorted by Datagraph Rating.

**Top 250 DG Over 500 Mil (NASDAQ)**
The 250 stocks with the highest Datagraph Rating that have a market cap of at least $500 million. These stocks are traded on NASDAQ and are sorted by Datagraph Rating.

**Top 250 DG Under 500 Mil**
The 250 stocks with the highest Datagraph Rating that have a market cap under $500 million. These stocks are traded on the NYSE or AMEX and are sorted by Datagraph Rating.

**Top 250 DG Under 500 Mil (NASDAQ)**
The 250 stocks with the highest Datagraph Rating that have a market cap under $500 million. These stocks are traded on NASDAQ and are sorted by Datagraph Rating.

**Top Earnings Per Share Rank Stocks**
The top 100 companies traded on NYSE, AMEX or OTC by their earnings per share rank. This list is sorted by earnings per share rank.

**Top Relative Strength Stocks**
The top 100 companies traded on NYSE, AMEX or OTC by their relative strength rank. Tender offers and stocks under $7 are omitted. This list is sorted by relative strength value.

*Updated Daily
** Updated Semimonthly

To view a Performance List, follow these instructions:

Select the desired Performance List by double-clicking on the list or by pressing the Tab key and use the arrow keys to highlight the desired list. Once the list is highlighted, click on the Open button or press the Enter key.

A window containing the stocks in the selected Performance List will be displayed. The list includes current data...
Portfolios

This selection allows the user to create customized portfolios, including importing portfolios from text files.

Create a Portfolio

To create a portfolio, select the Create button in the Portfolio Manager. A window will appear that asks for a portfolio name. The stocks in the portfolio will be sorted in alphabetical order unless "Do Not Sort List By Company Name" is checked. In this case, the stocks will be listed in the order they are entered. After naming the list, select OK. A window will open and securities are ready to be added. To add a security to the list, bring up a graph of the security in the main window and select the Add button in the portfolio window or use the Insert key on the keyboard. A confirmation window will briefly appear, indicating that the security has been added to the list. To delete a security from the list, highlight the name of the security in the portfolio window and select the Delete button or use the Delete key on the keyboard.

Printing Portfolio

To print the list of stocks in the portfolio click on the Print icon on the top left of the portfolio list.

To print the graphs, check the Print box at the top of the portfolio window and clicking on the play button, graphs will be sent to the printer as they are displayed on screen.

Up to four graphs per page may be printed. To print multiple graphs, open up to four windows displaying different graphs. Check the Print field and the Multi Graph field and click on the play button. To print the list of securities in the portfolio, click on the printer icon in the upper left corner of the portfolio window.

Exit Portfolio

To exit the portfolio list, the user may either select the Exit button or use the Escape key on the keyboard.

Import Portfolio

To import a list of securities from Microsoft Word or Excel save the list as a Text Tab Delimited file (.txt). The first column must contain the O'Neil stock symbol*. The user also has the option to import stocks by their CUSIP, SEDOL, or ISIN if needed. Additionally, the user can import the exchange the stock trades on as well as the number of holdings by checking the respective boxes and including the information in the respective columns. If the user is saving the text file in a workbook application, a single space needs to be inserted between each item.

To import the file, click on the Import button in the Portfolio Manager. The user must then select the file to be imported. Click the Open button, name the portfolio, click OK and the importing function will begin. If holdings are also being imported, please check the Include Holdings field.

NOTE: The O'Neil Stock symbols, especially in the case of foreign or regional exchange stocks, may differ from other databases. To verify a symbol, use the Name Search feature. For detailed instructions on using Name Search, please see Section I.
View Portfolio

There are two methods of viewing the graphs from the portfolio. The first method is to view one graph at a time by double-clicking on the symbol to be viewed, and pressing the space bar on the keyboard to cycle through the list. The second method of viewing graphs allows the user to scroll through the entire list by selecting the first graph to be viewed and selecting the play button at the bottom of the window. Play may be paused or stopped by using the buttons on the browser toolbar. Press the pause button to pause playing and study the graph in more detail. Press the pause button again to resume the scrolling of the list. In order to stop the scrolling process and return to the list, click the stop button on the browser toolbar, press any key on the keyboard (except the Enter key or space bar) or click on the WONDA graph. To exit the window, select the Exit button.

NOTE 1: The scroll speed is set at six seconds per graph. Setting the speed is done through Settings Menu, Graphic Options and select Play Options.

NOTE 2: Lists, custom screen reports, portfolios and Data Monitors can be merged into portfolios with a simple click, drag and drop motion. Press the Alt key while simultaneously holding down the left mouse button in the window of the list to be merged. Drag the contents of the list into the window of the portfolio. A small graph icon will appear while dragging the list. Once the icon is placed in the desired window, release the Alt key and the mouse button. A dialog box will appear confirming the merger of the list into the Portfolio. Click the Yes button to complete the process. To purge a portfolio, press the Alt key and click, drag and drop the list outside of the window. To select individual stocks hold the Ctrl key down and highlight the desired stocks. Then, using the left mouse button, drag the selection to the new portfolio. An individual stock can be copied into an existing portfolio simply by highlighting the stock, holding down the left mouse button and dragging it into the Portfolio. A small graph icon will appear while dragging the stock. Release the mouse button once the icon is in the desired window and the stock will be added to the portfolio. A dialog box will confirm the addition of the stock to the portfolio. To delete a stock from a portfolio, highlight the stock, hold down the left mouse button and drag the stock outside the portfolio. Release the mouse button once it is outside the window.

Delete Portfolio

The user may delete a list from the Portfolio Manager by highlighting the list name. Once the list is highlighted, select the Delete button.

Exit Portfolio

To exit this feature, the user may either select the Exit button with the mouse or use the Escape key on the keyboard.

Add Holdings Data

This feature allows the user to add holdings information to the securities listed in a portfolio for use in graphing a market cap weighted line in the comparisons feature. To add holdings to a company in the portfolio, highlight the company name and right-click with the mouse. Type the shares in the field labeled Holdings and then click OK to save it.
Exporting Portfolio to Excel

Portfolio data can be exported to Excel by clicking on the lavender “P” notebook icon in the upper left corner of the Portfolio window. From the drop down menu, choose Export to MS Excel. All portfolio data will be exported, including ticker symbol, company name and share holdings, if applicable. Alternatively, clicking on the Excel icon in the portfolio window will export the data.

Screening on a Portfolio

This feature allows the user to filter through a portfolio using the custom screen function. By either using an existing custom screen or creating a new custom screen, the user may filter out stocks from the portfolio that do not meet the desired criteria. For detailed instructions on screening on a portfolio, please see List Box Options - Screening on the List feature in Section I.

Sharing Portfolios

Portfolios can be shared with other WONDA users within the same firm. To share a portfolio with another user in the network, select the portfolio to be shared and then click the Share With button in the Portfolio Manager. A list of users that have currently been granted access to the portfolio and their permissions (Read Only or Read and Write) will appear. Select the Add button to choose more users with whom to share the portfolio. Select the user and click the Add User(s) button to share the portfolio with read only permission. Take the check mark off of the User Can Read Only selection to give the user read and write permissions. Multiple users may be added by holding down the Shift key. Click on the Close button after users have been added. Click the Done button to close the window.

To view portfolios that have been shared by another user in the network, select the Shared By button in the Portfolio Manager. The Network Portfolio Sharing window will open. This window contains a list of the users’ portfolios and the portfolios that have been shared by other users. Click the + to see the list of portfolios for each user. Select the portfolio to be opened and click the Open button or double-click on the portfolio name. The portfolios that have been shared will show an R on the folder if it has been shared with read only permission and a W if it has been shared with read and write capabilities. Click the Done button to close the window.

Common, Unique and Merge Portfolios

Two or more portfolios may be selected to find those issues that are common or unique between them. Use the Ctrl key to highlight the portfolios in the Portfolio Manager. Once the portfolios are selected, choose Common to create a portfolio of issues that are in all of the selected portfolios or Unique to find the issues that are unique to either all or one of the selected portfolios. The merge button is also available to create a portfolio combining securities from the selected portfolios. After the Common, Unique or Merge button is selected, a window will appear prompting the user to name the new portfolio.

Snapshots in a Portfolio

To set a snapshot of stock at any point in time, use the Change Date feature located under the Tools button. Modify the date field as desired and click Daily, Weekly or Monthly to draw the graph. To set a snapshot, click the snapshot button within the portfolio window to record it. A message will display that the snapshot has been recorded in the portfolio.
A second way to set a snapshot is to draw a Daily, Weekly or Monthly graph and use the Track Price feature located under the Tools button. Drag the Track Price to the trading day where the hash marks cross. Once your cursor is on the desired day while holding down the mouse button, click the Insert button on the keyboard and a message will display that the snapshot has been recorded in the portfolio.

There is a Snapshot date column in the portfolio to view the Snapshot stocks. To hide the snapshot stocks, click the Hide Snapshots check box and the column will disappear.

**Transaction Records**

Transaction Records are available to track and record trades that a person or firm makes. Users can see the buys and sells of a stock and also view details of each transaction on the graph.

Selecting Transaction Records under the Lists button will open the Transaction Records Manager. This window allows the user to create new transaction collections, share transactions and view transactions other users have shared.

To record a trade or transaction, activate the Notes icon by depressing the Pencil Icon. Then click the Record Transaction icon at the end of the toolbar. Place the cursor on the graph and hold down the left mouse button. Let go of the button when the cursor is on the day for which the transaction should be added. As soon as the left mouse button is released, a Transaction Record window will appear to input data. A time stamp is automatically inserted for the day, time, and volume of the stock (if it is not the current trading day, the total volume is used in this field). There are also fields for notes, related document links and web pages. Additional notes can be stored by clicking on the blue notes button. After the information is added into the Transaction Record window, click the Apply button to save the information and the OK button will save the transaction and close the window. A Transaction Record will be posted along the bottom of the graph. By placing the cursor on the symbol, a hover box will appear for easy access to the information. To edit the information or access the related links or web pages, click on the transaction symbol and it will open the Transaction Record window.
The **Trans List icon** is an easy way to bring up the list of stocks within a collection that contain transaction records. To set an active list of stocks, click on the Lists button and select Transaction Records. Opening a list will set it as active.

To view all transactions on the stock currently graphed select the **Trans Rpt icon**. This report can be sorted by any column heading and screened by any category.

Transactions may be shared with other WONDA users within the same firm while in the Transaction Records Manager. Select the Share With button, then click the Add button and select the users with which to share the collection. To view transaction records other users have shared, select the Shared By button in the Transaction Records Manager, highlight the record you want to view and select the Open option.
Notes

The Notes feature gives the user the capability of creating, storing, and printing personal notes on daily, weekly and monthly graphs. These notes include text, arrows, trend-lines, circles, squares, arcs, parallel lines and pointers.

In order to create notes, the Notes must be activated by clicking the icon on the Notes toolbar. Click the toolbox icon to be graphed, move the mouse to the desired location on the graph, then click to display the object or drag the mouse until the object is the desired size.

When using the parallel lines note, the arrow keys on the keyboard will move the bottom parallel line when the Ctrl key is held down. In order to shift both parallel lines, click the right mouse button on the parallel lines, then drag the lines to the desired location on the graph.

The letter A on the toolbar is used to draw a text box. The box containing the text must first be formed before text may be added. Once the text box is made, type in the comments and press Enter. If the text box created is too small, a default-size box will be produced. If the text box is too large, it can be made smaller by simultaneously clicking and dragging the borders. To edit existing text, double-click the text box and make the changes.

After the Notes have been created, viewing the Notes can be achieved clicking on the Note icon .

Individual notes can be deleted by moving the cursor over an object or text and double-clicking with the right mouse button. To delete all notes associated with a particular stock, click the X in the Notes Toolbox. Several Notes collections may be created by clicking on the Create button in the Notes Manager.

Notes may also be shared with other WONDA users within the same firm. Select the Share With button, then click the Add button and select the users with which to share the collection. To view notes other users have shared, select the Shared By button in the Notes Manager, highlight the record you want to view and select the Open option.
New Leaders/New Laggards
The New Leaders/New Laggards are not part of the base package and require an entitlement.

This section enables users to view lists of securities appearing in the O'Neil New Leaders & Laggards Review Idea Services New Leaders Large-Cap Review, New Leaders Review, New Laggards Large-Cap Review, and New Laggards Review are sorted from highest to lowest using a combination of EPS Rank and Relative Strength values. To access the stocks in each list, click on the List Button and on the desired list. Stocks shown in green font represent the addition to the list during the current week. The lists are reset each Friday after market close. To subscribe to the New Leader/New Laggard lists, please contact your William O'Neil Account Executive at 800-545-8940.

ADR Data

This feature allows access to the O'Neil ADR Database®, which includes information on over 500 publicly traded ADRs in 48 countries. Choosing this option will bring up the list of countries with ADR Data available. Double click on one of the countries in the list to view the ADRs from country.

This list will also include an O'Neil ADR index, a formal country index and/or currency graph, if available.

Tools

This menu contains various program tools.

Change Date

Change Date allows the user to retrieve historical graphs for stocks, mutual funds, industry groups and market indices.

To enable this feature, click the Change Date option from the Tools menu. A check mark will display next to the option to indicate that it is activated. A date toolbar will appear allowing the user to adjust the day, month and year.

Click on the drop down arrow and scroll through the list to find the desired date. To view the historical graph, click on the date and then press the Enter key on the keyboard or click on the graph button with the mouse. If a weekend day is selected, the date will automatically default to the Friday before the weekend. The graph appearing on the screen will end with the selected date and graph the previous time period accordingly. The date will appear in the lower right-hand corner of the graph. To disengage the feature, click Change Date once more.

These historical graphs can be printed by clicking on the print icon or by selecting the Print option under the File menu. Tools such as track price have been adjusted to work in conjunction with Change Date. In addition, Point and Figure graphs may be manipulated using Change Date.

Archive

The Archive feature provides the capability of storing graphs of a specific time period, for subsequent viewing. Similar to the process of creating Portfolios, the process for creating an
archive file begins by naming the archive file. Select Archive from the Tools menu and name the file. After clicking OK, a window will appear indicating that graphs are ready to be archived. To add a graph to the file, bring up the graph of that security on the screen and select the Add button.

Archiving a portfolio or Data Monitor is slightly different than archiving individual stocks. To archive the entire list of graphs, click the Copy box in the window, then select the play button in the lower right-hand corner of the window. After providing the archive file with a name, selecting a path drive and clicking the OK button, a window containing all the stocks within the portfolio or Data Monitor will be displayed.

**Track Price**

Selecting this tool allows the user to view the detailed price and volume information for the Daily, Weekly, Monthly, or Intraday graph. Once Track Price has been selected, hold the left mouse button down and drag the cursor across the screen to scroll through each period’s information. Clicking with the right mouse button at any time will also activate this feature. To exit this feature, select Track Price again from the Tools menu.

The track price box can be printed out on a graph. To enable this feature, select Print Track Price from the File menu. Hold the left mouse button down and drag the cursor across the screen to view the track price box in the upper left-hand corner. Wherever the mouse button is released is the data point for the track price box that is printed on the graph. A cross bar appears in the graph correlating with the track price. To exit this feature, click Print Track Price again.

**Line Pen**

Selecting this tool allows trend lines to be drawn by the user. Once the Line Pen feature has been selected, choose the point from which the line is to be drawn, hold the mouse button down, drag the cursor to draw the line and release the mouse button. To exit this feature, select Line Pen again. This feature is also used to add or modify trend lines in Alerts.

**Search**

The Company Name Search can be accessed by selecting Search from the Tools menu, or by typing a forward slash (/) in the symbol field. Once the search window appears, a company can be found by typing part of or the entire company name in the top field of the window. A list of names is pulled from the host. To view that company’s graph, double-click the name with the mouse or highlight it and click the Graph button. To exit this feature, click on the Close button.
NOTE: Company names that begin with abbreviations or letters are found by typing in the first letter of the name and then a space. The O'Neil Stock symbols, especially in the case of foreign or regional exchange stocks, may differ from symbols in other databases. To verify a symbol, the Name Search function may be used. For detailed instructions on using the Name Search function, please see Section I.

**Change Password**

This option will allow a user to change his or her password at anytime. This feature is intended for those users who do not have IP address security. Click on the Change Password feature under the Tools button and type in the old and new passwords in the spaces provided. After clicking the OK button the new password will be stored and appear in the WONDA User Profile. The old password will no longer be valid.

**WONDA Macros**

Macro shells have been created that can be used for several different WONDA functions. This feature is found by selecting the WONDA Macros option from the Tools menu. A window will appear with the shells created by William O'Neil + Company, Inc. Highlight the name of the desired macro and select the Modify button. This will bring the user into the Macro where modifications can be made. Directions are provided within each macro shell for assistance with modifications. Once completed, save the macro as a different name by using the Save As button. The new macro will appear in the Macros window. To run any macro, highlight the macro and select the Run button or double-click on the name of the desired...
macro. Shells may be modified as many times as needed. Client Services will provide assistance with Macros to clients wishing to modify or create custom macros.

**Scheduling a Custom Screen to Run**

To schedule a macro to run at a later time, the following command should be entered into Microsoft Scheduler:

C:\oneil1\WONDA.EXE MacroName

The WONDA directory may differ from c:\oneil1. Verify the path on the PC before attempting to run the macro from Microsoft Scheduler. For users on the Windows XP operating system, the Network Password (with Administrative Rights) must be entered into Microsoft Scheduler.

In order to run more than one scheduled macro, WONDA must be closed in between each run. To accomplish this, add QUIT to the end of the macro. Alternatively, several macros can be combined into one macro file thereby eliminating the need to schedule multiple jobs.
Sect II Appendix A: How to Read the Blocks

II. Appendix A - How to Read the Fundamental Block

Explanation of the features included in the Fundamental Block:

1. **Sales (Mil$)** - Annual sales in millions of dollars. Amount is reported as income for industrial companies, operating income for banks, gross income for finance companies, premium income for insurance companies, operating revenues for utility companies, and total income (rental, mortgage, and gains on real estate sales) for real estate investment trusts.

2. **Sales % Change** - The percent change from the prior year in annual fiscal year sales.

3. **Return On Equity %** - Percentage computed by dividing annual income (before extraordinary items, discontinued operations, cumulative accounting adjustment and non-recurring items) by average of the latest fiscal year and prior year's stockholders' equity.

4. **Pretax Margin %** - (pretax profit margin percentage) - Computed by dividing income from continuing operations before taxes by annual sales.

5. **Cash Flow/Share $** (cash flow per share) - Derived by adding the company's net income, depreciation, and depletion and dividing this figure by the total number of shares outstanding.

6. **Earnings (earnings per share)** - Earnings per share record showing reported, split adjusted diluted earnings per share (excludes extraordinary items, discontinued operations, cumulative accounting adjustments, and non-recurring items) for each of the last nine years.
7. **Fiscal Year End** - month in parentheses denotes fiscal year end.

8. **Business Summary** - describes recent corporate activity with emphasis on sales and income breakdown, products and operating locale. Sales and income figures are percent-to-total of business. The parenthesized figures are income percentages.

9. **EPS Rank** - Measures a company's earnings per share growth over the last 5 years and the stability of that growth compared to all the companies in the database. Four different factors are used in the calculation: the percent increase in the most recent quarter versus the same quarter a year ago, the percent increase in the prior quarter versus the same quarter a year ago, the 5-year earnings growth rate (3-year earnings growth rate is used if a 5-year earnings growth rate is not available) and the earnings stability factor. These factors are ranked separately and weighted according to a proprietary formula. This result is then ranked on a scale from 1 to 99, 99 being the highest. A rank of 70 means the company had a better earnings record than 70% of all companies.

10. **Company's Telephone Number**

11. **Estimated Date Of Next Earnings Report** is based on past earnings report dates. A double asterisk (**) indicates earnings are expected in the next 2 weeks.

12. **Company's Web Site Address**

13. **Company Headquarters** - indicates city and state where the corporate offices are located. Canadian provinces and foreign countries are indicated for headquarters outside the USA.

14. **Ex-Dividend Date** - the date that the stock is scheduled to go ex-dividend. Ownership must be maintained until this date to receive the dividend payment.

15. **Date of Incorporation** - indicates when the company started business as a corporation.

16. **Days Trading Volume Short** - indicates number of days required to cover total short volume reported twice per month. Number of shares sold short is divided by the stock's average daily volume at time of short volume report.

17. **Investment Banker** – The most recent primary investment banker.

18. **Management Owns** - is the percentage of the shares outstanding owned by management.

19. **Active Call/Put Option Trading** - on organized exchanges: American (AMEX), Chicago Board Options (CBOE), Philadelphia (PHIL), Pacific (PCSE), and New York (NYSE) Exchanges.

20. **"Yr" Estimate (consensus EPS estimates for the current year)** - Earnings estimates are provided by Thomson First Call®.

21. **Earnings Per Share Estimate Percentage Change** - the percent change of the current year earnings per share estimate versus previous fiscal year reported earnings. Earnings estimates are provided by Thomson First Call®.

22. **Estimate Revision** – indicates a revision on the consensus earnings estimate. Direction of arrow indicates direction of change. Earnings estimates are provided by Thomson First Call®.

23. **“Yr” Estimate (consensus EPS estimates for the next year)** - Earnings estimates are provided by Thomson First Call®.
24. **Earnings Per Share Estimate Percentage Change** - the percent change of next year’s earnings per share estimate versus the prior year’s consensus estimate. Earnings estimates are provided by Thomson First Call®.

25. **Earnings Growth Rate Percentage (3-year period)** - based on an earnings growth rate trend line calculated using the least-squares curve fit over 2-3 years of earnings per share on a trailing 4 quarter basis. Growth rate will be calculated only if there is a minimum of 8 trailing 4 quarter periods of positive earnings (minimum of 11 quarters of data).

26. **Earnings Growth Rate Stability Factor (3-year period)** - in percentage form, indicates one standard deviation of the variability around the trend line fitted through 2-3 years of earnings per share history. A stability of 5 indicates that the majority of all 12-month earnings summations fall within a 5% band around the trend line for the 3-year period. The lower the number, the more stable the stock’s earnings history.

27. **Sales Growth Rate Percentage (3-year period)** - based on a sales growth rate trend line calculated using the least-squares curve fit over the latest 3 years of sales history on a trailing 4 quarter basis.

28. **Earnings Growth Rate Percentage (5-year period)** - based on an earnings growth rate trend line, calculated using the least-squares curve fit over 3 to 5 years of earnings per share on a trailing 4 quarter basis. Growth rate will be calculated only if there is a minimum of 12 trailing 4 quarter periods of positive earnings (minimum of 15 quarters of data).

29. **Earnings Growth Rate Stability Factor (5-year period)** - in percentage form, indicates one standard deviation of the variability around the trend line fitted through 3 to 5 years of earnings per share history. A stability of 5 indicates that the majority of all 12-month earnings summations fall within a 5% band around the trend line for the 5-year period. The lower the number, the more stable the stock’s earnings history.

30. **Sales Growth Rate Percentage (5-year period)** - based on a sales growth rate trend line, calculated using the least-squares curve fit over the latest 3 to 5 years of sales history on a trailing 4 quarter basis.

31. **Composite Rating** - Combines EPS Rank, Relative Strength Rating, Industry Group Relative Strength Rating, SMR Rating, Accumulation Distribution Rating and the stock’s percent off its 52 week high into one rating. More weight is placed on EPS and RS Ratings and the stock's percent off its 52 week high. Results are then compared to all other companies, and each company is assigned a rating from one to 99 with 99 being the best. A 90 rating means that the stock has outperformed 90 percent of all other stocks in terms of its combined ratings.

32. **SMR Letter Rating** – Sales, Margin and ROE rating measuring the sales growth, profitability and efficiency of a company’s sales growth rate over the last 3 quarters, before and after-tax profit margins, and ROE. Sales growth and after-tax margins are computed using quarterly figures, and ROE pre-tax margins are annual. All four factors take into account acceleration (rate of increase). The ratings range from “A” to “E” (“A” being the best, representing the top 20% of all stocks).

33. **Inventory Turnover** - the number of times an inventory is replaced on average during a year. Calculated by dividing fiscal sales by inventory (beginning plus ending inventory for fiscal year divided by 2).

34. **Inventory Turnover Rank** - the percentile rank of this company’s rate of inventory turnover. A percentile rank of 70 signifies this company has a greater inventory turnover rate than 70% of all companies.
35. Debt % (debt to equity percentages) (last 3 years) - long term debt divided by shareholders equity, including preferred stock, using fiscal year-end values (latest year on right).

36. Tax Rate (last 3 years) - computed by dividing federal, foreign and state income taxes (including deferred taxes) by pretax income (latest year on right).

37. Backlog (last 3 years) - backlog of orders at year-end divided by sales reported in same fiscal year (latest year on right).

38. Bk Val (stock price relative to book value) - computed by dividing the prior day's price by the per share book value (total shareholders' equity for fiscal year-end indicated divided by common shares outstanding).

39. Div Gr Rt (dividend growth rate) - based on a dividend growth rate trend line, calculated using the least-squares curve fit over 3 to 5 years of cash dividends paid per share on a running 12-month basis. Irregularly paid dividends are normalized on a quarterly paid basis for growth rate computation. The number in the Parentheses is the Dividend Stability Factor. The Dividend Stability Factor in percentage form, indicates one standard deviation of the variability around the trend line fitted through 3 to 5 years of dividend history. A stability of 5 indicates that the majority of all 12-month dividend summations fall within a 5% band around the dividend trend line for the 5-year period. The lower the number, the more stable the dividend history.

40. Alpha Stabilization Factor - Monthly alpha divided by monthly standard deviation. This figure measures potential reward against risk. The higher the number the better.

41. Alpha - An expression of how much the stock would have appreciated or depreciated on average on a daily basis over the last year assuming the S&P 500 remained unchanged during the period. For example, an ALPHA of 0.1 means the stock's price would have appreciated at the rate of .1% per day over the last year, assuming the S&P 500 remained unchanged. This item is updated weekly.

42. Beta Stability Factor - in percentage form, the coefficient of determination (r-squared) derived from a least-squares regression analysis that measures the relationship between the percentage movement of the current stock price and the S&P 500 Index. A stability factor of 85 denotes that 85% of a stock's risk is market related while 15% is unique to the stock.

43. Beta - measures the stock's sensitivity to movement in the general market over a 12-month period. A Beta of 1.50 signifies a stock tends to be 50% more volatile than the S&P 500.

44. DIV (dividend yield) - calculated by dividing the annualized dividend by the stock's closing price. Yields are computed weekly (second figure in box).

45. DIV (annualized dividend) - calculated by multiplying the latest reported regular divided plus extra dividends reported in the last four quarters by four (first figure in box).

46. R and D (research and development percent of sales) - latest reported amount spent on R and D divided by sales reported for the same fiscal year.

47. Industry Group Rank - A proprietary number obtained by calculating the least-squares curve fit of summed prices on certain stocks within that industry. Another calculation is then done using all companies in the group. Separate weightings are used for different time periods. Groups are ranked from 1 (best) to 197. Current week at right.
48. **Relative Strength** - result of calculating the stock's percentage price change over the last 12 months with extra weight (40%) assigned to the latest 3 month period (with each remaining quarter receiving 20% each). All stocks are arranged in order of greatest price percentage change and assigned a percentile rank from 99 (highest) to 1 (lowest). A value of 55 means the stock outperformed 55% of all stocks during the period measured, current week at right.

49. **Accum/Dist Rating (Accumulation/Distribution Rating)** - proprietary rating calculated as an exponential moving average of inter- and intra-day price and volume statistics. The effect of a single day's trading becomes insignificant after about 60 days. The values range from +100 to -100. Positive ratings from +100 to 0 mean a stock has been showing accumulation. Negative ratings from -1 to -10 are neutral, and ratings below -10 mean a stock has been under distribution.

50. **Up Down Volume** - ratio of the daily up volume to the daily down volume which is based on a 50-days and derived by dividing total volume on days the stock closed up from the previous day by the total volume on days it closed down. A ratio better than 1.0 implies a positive demand for the stock, current week at right.

51. **Avg Daily Vol (00)** - the average daily volume of stock traded on average each day for the last 50 trading days. Figure displayed is in 100's and given for the past 9 weeks to show the change in investor activity in the stock, current week at right.

52. **Datagraph Rating** - a number incorporating many elements that may influence stock prices. This rating is based on a formula that assigns certain weightings to reported earnings (primary operating), capitalization, sponsorship, relative strength, price-volume characteristics, group rank, and other factors. Ratings range from 1 (lowest) to 99 (highest). Current week at right.
II: Appendix B - How to Read the Earnings Block

Explanation of the features included in the Earnings Block for both domestic and global stocks.

1. **Earnings Per Share Estimate Percentage Change** – the percentage change from the actual earnings vs. the estimated eps for the most recently reported qtr.

2. **Funds/Shares (000)** - quarterly summary of the number of mutual funds owning the stock and the total shares held at the time. Shares are expressed in thousands. Shares 10 million and above have (M) for millions after the number and (M+) when shares exceed the number indicated by half million.

3. **PE Low-High** - quarterly high and low price/earnings ratio derived by dividing the highest and lowest weekly closing prices during the quarter by 12-month earnings at quarter end.

4. **Margin After Tax** - computed by dividing quarterly income (after-tax and before extraordinary items, discontinued operations, cumulative accounting adjustments and non-recurring items) by quarterly sales.

5. **% Change (Sales)** - the percentage change from the quarterly sales or revenues in the comparable quarter of the previous year.
6. **Sales (Mil $)** - quarterly sales in millions of dollars. Amount is reported as income for industrial companies, operating income for banks, gross income for finance companies, premium income for insurance companies, operating revenues for utility companies and total income (rental, mortgage and gains on real estate sales) for real estate investment trusts.

7. **% Change (EPS)** - the percentage change from the quarterly earnings in the comparable quarter of the previous year.

8. **Earnings/Shr ($)** - quarterly earnings per share (split adjusted) before extraordinary items and discontinued operations. A § is shown next to quarterly earnings when pretax non-recurring items are included. Certain real estate investment trusts report funds from operations per share and certain publicly traded investment companies report net asset value per share instead of earnings per share. The earnings per share calculation now provides a numeric year over year percent change value when comparing profitable earnings per share periods against unprofitable earnings per share periods. The formula used is as follows: (Current Period EPS – Year Ago Period EPS)/Absolute Value (Year Ago Period EPS). All EPS year over year percent change calculations based on negative year ago values will be flagged with a special character “#”. The previous method for comparing profitable earnings per share periods to unprofitable earnings per share periods was to flag this period with a “N/A”.

EX: Current Period EPS = $.10, Year Ago Period EPS = -$.03

**New Calculation**: ($0.10 - (-0.03)) = $0.13/$0.03 = #433%

**Previous Method**: noted by N/A

9. **Quarter Estimate** - figure is not a William O’Neil & Co. quarterly estimate. It is a consensus estimate maintained in the O’Neil database.

10. **Earnings Per Share Estimate Percentage Change** - the percentage change from the actual earnings in the same quarter a year earlier.

11. **High and Low Price/Earnings Ratios** - PE ratios for the last five years are derived by dividing the highest and lowest prices during a quarter by trailing 4 quarter’s earnings at quarter’s end. Latest 20 quarters are used for this evaluation and the highest and lowest price/earning ratios within this 5-year period are indicated.

12. **Now (Current) Price/Earnings ratio** - calculated by dividing the current day’s closing price by latest trailing four quarters earnings.

13. **PE Ratio Based on Earnings Estimate** - calculated by dividing the most recent week’s closing price by the estimated earnings for the current fiscal year. If 3 quarters have been reported the estimated PE will be based on the next fiscal year’s earnings estimate.

14. **Current Price/Earnings Ratio Relative to the S&P 500 PE Ratio** - 1.6 X S&P means the stock’s PE ratio is 60% above the S&P’s PE ratio.

15. **Quarter Month End** - The default view is to display the quarterly calendar month end. To display the fiscal quarter end right click on the mouse and select fiscal.
16. **Earnings/Shr (S)** - The frequency code displays an “S” to indicate semiannual reporting of earnings. Semiannual periods are also color coded in a light green. The frequency code and color shading can be disabled by the user.

17. **Earnings/Shr (A)** – The frequency code displays an “A” to indicate annual reporting of earnings. Annual periods are also color coded in a light blue. The frequency code and color shading can be disabled by the user.

18. **Earnings/Shr Currency** - Indicates the currency displayed in the Earnings Block. Currencies can be converted when the setting “Convert Fundamental currency to agree with chart currency” is enabled by selecting the desired currency in the dropdown box.
This page left intentionally blank
II: Appendix C - Toolbars

By placing a check in the appropriate box(es) under Toolbars selection in Graphics Options menu, the user has the choice of displaying up to seven different types of Toolbars. Start by clicking on the Settings Menu > Graphic Options > Toolbars to access the toolbar selections.

Pictures and descriptions of the Toolbars are provided below as set up with the default toolbar setting. Additional icons will be available to customize and are also listed below. All toolbars can be moved in groups to either side of the graph or below the graph. The Auto-save toolbars feature saves manual changes to your toolbars.

COMPANY NAME, COUNTRY and CURRENCY TOOLBARS

- Company Name
- Country
- Currency
- Search Feature
## STOCK DATA TOOLBAR

<table>
<thead>
<tr>
<th>Default Toolbar Icons</th>
<th>Additional Icons Available for Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Graph</td>
<td>Company News</td>
</tr>
<tr>
<td>Fundamental Block</td>
<td>Condensed Balance Sheet Block</td>
</tr>
<tr>
<td>Earnings Block</td>
<td>Condensed Income Block</td>
</tr>
<tr>
<td>Sponsorship Block</td>
<td>Financial Ratios Block</td>
</tr>
<tr>
<td>IPO Story</td>
<td>Index Membership</td>
</tr>
<tr>
<td>Company Articles</td>
<td>Enhanced Edgar</td>
</tr>
<tr>
<td>Corporate Events</td>
<td>Thomson Equity Strategies</td>
</tr>
<tr>
<td>Sponsorship Report</td>
<td></td>
</tr>
<tr>
<td>Custom Data Block</td>
<td></td>
</tr>
<tr>
<td>CEO Profile</td>
<td></td>
</tr>
<tr>
<td>O’Neil Resource Center</td>
<td></td>
</tr>
<tr>
<td>Fund Center</td>
<td></td>
</tr>
<tr>
<td>Scrolling Headlines</td>
<td></td>
</tr>
</tbody>
</table>
**GRAPhIC OPTIONS TOOLBAR**

<table>
<thead>
<tr>
<th>Default Toolbar Icons</th>
<th>Additional Icons Available for Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stochastics</td>
<td>Disable Volume</td>
</tr>
<tr>
<td>RSI</td>
<td>O’Neil Lists</td>
</tr>
<tr>
<td>Accumulation Distribution</td>
<td>Mobile Access</td>
</tr>
<tr>
<td>MACD</td>
<td></td>
</tr>
<tr>
<td>Institutional RS</td>
<td></td>
</tr>
<tr>
<td>Relative Strength Line 1</td>
<td></td>
</tr>
<tr>
<td>Relative Strength Line 2</td>
<td></td>
</tr>
<tr>
<td>High/Low Prices</td>
<td></td>
</tr>
<tr>
<td>High/Low Percentages</td>
<td></td>
</tr>
<tr>
<td>Log Volume</td>
<td></td>
</tr>
<tr>
<td>Change Scale</td>
<td></td>
</tr>
<tr>
<td>Favorites</td>
<td></td>
</tr>
<tr>
<td>Thomson First Call®</td>
<td></td>
</tr>
<tr>
<td>Link Windows</td>
<td></td>
</tr>
</tbody>
</table>
NOTES TOOLBAR

Default Toolbar Icons

Enable/Disable Notes

Up Arrow

Down Arrow

Circle

Square

Line

Text Box

Pointer

Arc

Parallel Lines

Delete All Notes

Notes List

Transaction Records List

Transactions Records Performance Report

Record Transaction Records
BROWSER TOOLBAR

**Default Toolbar Icons**

- Go Back Page
- Go Next Page
- Stop
- Refresh Page
- Home Page
- Next Window
- Pause Playing
- Stop Playing
III . Menu Commands

File Menu

Real Time Quotes

This option allows the user to select between real time quotes and 20-minute delayed pricing. Real time quotes can be enabled if a windows-based quote service with a DDE (Dynamic Data Exchange) interface is linked to WONDA User Profile. A DDE interface allows data to be exchanged between applications in a windows environment. To see if a quote service is compatible with the WONDA application, call Client Services at 800-419-6632.

Copy

This option allows the user to copy a graph exclusively (without the tool bars) to another application with a click of the mouse. To copy a graph, go to the File menu and select the Copy option. This will take a screenshot of the graph and hold it until it is pasted into another application. The Fundamental and Quarterly/Annual blocks may also be copied by selecting the Copy option located in the upper left corner of each data block.

Print

This option initiates a print request of the graph. Fundamental and Quarterly blocks will only print on a weekly graph in order to match the financial time line with the price and volume time line.
Print Multiple

This feature allows a user to print up to four Daily, Weekly, Monthly or Intraday graphs (in any combination) on a single page. To print multiple graphs, open the desired number of new windows and click on the Print Multiple option.

Print Track Price

This feature prints the track price box in the upper left-hand corner of the graph. To enable this feature, place a check mark next to the Print Track Price option from the File menu. Then, from the Tools button, select Track Price. Hold the left mouse button down and drag the cursor across the screen to view the track price box.

A cross bar appears on the graph corresponding to the date displayed in track price box. The location on the graph where the user releases the mouse button is the data point for the track price box that will be printed on the graph when Print Track Price is activated. To exit this feature, select the Print Track Price feature again.

NOTE: Track price can also be activated by clicking the right mouse button at any time.

Printer Setup

This allows the user to change the printer used by the WONDA application. The user can also change the page orientation. WONDA graphs will always print landscape, but reports and lists can be printed either in landscape or portrait layout by selecting the corresponding option within the printer setup box.
Page Setup
This enables a user to change the page margins for graphs. The default margin is 0.25 inches.

Change Report Font
This option allows the user to change the font of WONDA custom screen reports. Once this feature is selected, a menu will appear that allows the user to customize the font, font style and font size. These changes will only appear on hard copies and not on the screen.

Exit
This option exits the application.

Graph Type
There are several types of graphs that can be displayed. The default graph in WONDA is a Price/Volume graph. To change to a different type of graph, click on the Graph Type menu and select the desired graph type.

Price/Volume
This is the standard WONDA graph and shows the price/volume of an issue, index, industry group, etc. For detailed instructions on the options available for this type of graph, please refer to Section II.

Fundamental Graphs
This feature allows a user to graph fundamental data. This feature may be accessed from the Graph Type menu and selecting the Fundamentals option.
Typing a ticker in the blue symbol box and clicking Add or pressing the enter key on the keyboard will draw the last graph created. If no graphs have been created and saved, Quarterly Sales will be graphed.

New stocks may be added to the graph by typing the ticker into the blue window and clicking the Add button or by pressing Enter on the keyboard. Up to 20 stocks may be added.

From the Tools menu, selecting Show Data Points will display the values on the graph, or deselecting it will remove the values. Also, right-clicking on the graph will display the data in the track box.

To customize the data viewed in the track box, select the Track button. To remove an item from the track box, click on the item to remove the check mark.

To delete a stock from the graph, click on the Delete button. A list of the data item(s) and the stock(s) that are graphed will be displayed. Select the data item(s) and the stock(s) that you would like to delete. To reset the graph by deleting all stocks, choose Delete All.

There are several Preset Fundamental Graphs available from the Graph menu. Choose the desired graph and click Draw.

Create New Fundamental Graph

To create graphs, click on the Graphs button and select Create New. The Create/Edit Graph interface will open.
The first tab has the choice of Bar or Line graph. Enter a graph title and choose either a Bar graph or a Line graph. One or two data items may be graphed. Only one time period is allowed on the graph. If the 1st Item selected is a quarterly item and a 2nd Item is desired, it must also be a quarterly item. If there are two data items on a line graph, separate scales may be selected for each item. An absolute timeline with specific starting and ending dates, or a relative timeline with a specified number of periods going back historically from the current period may be selected.

In the Other Options section, there is the option to select actual values or indexed values for comparison. Also, a certain percentage change to be calculated and displayed in the track box is an option. For specific data items, the Dow Jones Industrial Average or the S&P 500 may be added when applicable. The OK button will save the graph and close the interface. Save & Graph will save it and create it on the screen. Use Save As to change the Graph Title. Reset will restore the default settings and Cancel will close the interface without saving it.

A scatter Graph may be created by selecting the Scatter Graph tab. Two data items may be plotted as a single point for several stocks. They may be graphed for the most recent time period or for several time periods. With the latter, a best-fit trend line may be added by checking Add Trend Line.
Section III: Menu Commands

### Edit Fundamental Graphs

To edit or view the options of any of the saved Fundamental Graphs, click on the Graphs menu and move the cursor to Edit Existing Graph. A list of the saved graphs will open. Click on one to edit. The Create/Edit Graph interface will open. Make changes and click OK, Save & Graph or Cancel.

### Delete Fundamental Graphs

To delete any of the Fundamental Graphs, go to the Graphs menu and move the cursor to Delete Existing Graph. A list of the saved Fundamental Graphs will appear. Click on the one to be deleted. A window will ask for confirmation to delete the saved graph and a second window will confirm that the graph has been deleted.

Another way to graph data is by using the links in Fundamental Reports in the O’Neil Resource Center. Data items in Fundamental Reports have been set up as links to draw a line graph in Fundamental Graphs. Click on any item in Fundamental Reports that is underlined and the item will be graphed. Other stocks may be added to this graph by typing the ticker in the blue symbol box and clicking on Add or pressing the Enter key on the keyboard.

### Comparisons

This feature allows a user to compare two or more stocks, O’Neil Industry Groups, portfolios, indices or mutual funds with an indexed base over a determined period of time. To activate this feature, select one of the following options from the Graph Type menu.
One Year (Daily) – This option plots a Daily Comparison graph of two or more securities. 260 trading days ago = 100.

Five Years (Weekly) – This option plots a Weekly Comparison graph of two or more securities. 260 weeks ago = 100.

Twenty Years (Monthly) – This option plots a Monthly Comparison graph of two or more securities. 260 months ago = 100.

After choosing one of these options, the corresponding Comparison window will open. The Comparison window will take the symbol of the most recently graphed WONDA graph and place it in the Symbol box. To add this symbol to the Comparison graph, click on the Add button or press the Enter key on the keyboard.
The index starts at 100 and plots the graph according to its percentage increase/decrease over the determined time period. The graph will not plot below zero. The upper left-hand corner of the Comparison graph displays the cumulative return in the Performance box.

**Changing Start and End Dates**

Both the Start and End Dates can be modified on a Comparison graph. Manually enter the Start and End dates in their corresponding fields or click the down arrow to use the Calendar feature. Once the dates have been set, click on the Apply button.

**Indexing Two or More Securities**

To view several securities on the same Comparison graph, type the first symbol into the Symbol box and click on the Add button. Repeat this process with the remaining symbols until they have all been added to the Comparison graph.

To delete a stock from the Comparison graph, click on the Delete button and select the security to be deleted or select Delete All.

**Creating and Indexing Baskets of Securities**

Baskets of securities can be indexed by using the comparisons feature. The basket of securities must be created as a portfolio or a Data Monitor. To add a basket of securities to a Comparison...
graph, bring up the Portfolio by selecting the portfolios option under the List button. Select the portfolio by highlighting it and selecting Open. Once the portfolio is open, it can be added to the Comparison graph by selecting either the Show Performance of (name of portfolio) – Price Weighted or the Show Performance of (name of portfolio) – Portfolio Weighted option under the Tools button. Both portfolio performance options calculate the return from the desired inception date through the current trading day (assuming all stocks were held for the entire time period).

In order to use the Portfolio Weighted option, the number of shares must be included in the portfolio. Enter the number of shares to the portfolio by right clicking on the company name in the portfolio window. A box will appear with a Holdings field. Enter the appropriate number of shares and select OK. This can be done for all companies in the Portfolio. Once complete, select the Show Performance of (name of portfolio) – Portfolio Weighted option from the Tools menu to view the comparison graph.

**Note:** Portfolios can be created from any type of list or report in WONDA (Custom Screen reports, Performance Lists and Institutional Lists) by using the Import function. For more information about portfolios, see Section II.

**Copy To Function**

Comparison graphs can be copied from one time period to another by using the Copy To Function. For example, in order to see all the stocks graphed on a Daily Comparison graph on a Monthly Comparison graph, select the Copy To Monthly option under the Tools button. All of the symbols from the Daily Comparison graph are automatically copied over to a Monthly Comparison graph.

**Creating Relative Performance Lines**

A user can also compare any stock, Performance List, Data Monitor, market index, mutual fund or O’Neil Industry Group to a stock or another list by creating a line that shows the relative performance of the two. To do this, add the desired symbols to the comparisons graph. Once this is done, select the option under the Tools button that reads Compare. Select the stocks to compare in the Compare window and click on the Compare button.
**Point and Figure Graphs**

A Point and Figure graph is a technical analysis tool that is used to follow the up or down momentum in the price movement of a stock. To view a Point and Figure graph, click on the Graph Type menu item and select the Point and Figure option and select either the Daily, Weekly or Monthly button of the stock to be graphed.

Point and Figure charts do not contain any volume history. The creation of a new column on the Point and Figure graph signifies the reversal of a price trend. The passing of time is noted with the numerals 1-9 (January – September) and the letters A, B, C, (October, November and December) to signify the first change for each month. The year is shown at the bottom of the column reading from left to right.

**Point and Figure Settings**

This option allows the user to specify the settings of the Point and Figure graphs. The default Point and Figure settings for Box Size and Reversal criteria have been set. In order to customize the Point and Figure Settings, you must follow these steps:

1. Click on the Graph Type
2. Select Point and Figure Settings
3. Make changes and click OK

Once the settings are saved, simply enter a ticker symbol and select the Daily, Weekly or Monthly button in order to view the Point and Figure graph.
Custom Screen Menu

Open Custom Screen

This item starts a menu driven system that assists the user in creating Custom Screens and Reports. For detailed instructions on creating and running Custom Screens, please refer to Section IV.

Open Last Screen

This option opens the most recently modified Custom screen. For detailed instructions on creating and running Custom Screens, please refer to Section IV.

Run Last Screen

This item runs the most recently modified Custom Screen. For detailed instructions on running Custom Screens, please refer to Section IV.

Run Custom Screen

This option allows the user to select a screen to run by bringing up the list of all Custom Screens that exist on the pc. For detailed instructions on running Custom Screens, please refer to Section IV.

Run Status

This option allows the user to run a Status Report for a Custom Screen by bringing up the list of all Custom Screens that exist on the pc. The Status Report displays the cumulative number of stocks in the O'Neil Database that meet the selection criteria of the screen it is run against. It is useful for determining any discrepancies and/or problems in the screen. For detailed instructions on running Status Reports, please refer to Section IV.
Section III: Menu Commands

Status
This option brings up the most recently run Status Report. For detailed instructions on pulling Status Reports, please refer to Section IV.

Report
This option brings up the most recently accessed Custom Screen report. For detailed instructions on pulling Custom Screen reports, please refer to Section IV.

Previous Reports
This option allows a user to retrieve Custom Screen reports that were previously generated. This is intended for users that cannot be on-line with the WONDA system (airplane or car), but need to view Custom Screen reports. For detailed instructions on pulling Custom Screen Reports, please refer to Section IV.

Preset Custom Screens
Preset Custom Screens were formulated to provide users with quick access to reports that utilize many of the unique aspects of the O’Neil Database. They cover many different investing principles and also provide screening templates that can be easily adjusted to fit each user’s customized needs. For detailed instructions on running Preset Custom Screens, please refer to Section IV.

CAN SLIM
Companies Reporting This Week
Top Companies in Top Industries
Recent New Issues
Sales and Earnings
Earnings Surprises--Current and Prior Day
Earnings Surprises--Current and Last 5 Days
Top Performing IPOs - 2 Years
Value
Settings

Graphic Options

The graphic options function allows the user to customize the look and feel of WONDA graphs. Graphic Options can be accessed by selecting Graphic Options from the Settings menu or by clicking on the Ctrl and F12 keys on the keyboard.

To enable an item, place a check mark in the box next to the selection and select OK. Once an item has been selected it will appear on all subsequent graphs. Alternatively, many of the options have a toolbar icon.
Section III: Menu Commands

Graphic Settings

Accumulation/Distribution

This option will display an Accumulation Distribution graph on a Daily graph. In addition to showing the company's capitalization and sponsorship information, the upper portion of the graph displays a daily history of the Accumulation/Distribution Rating. The thin line is the volume line, which is derived by multiplying the daily volume by the direction and change in the stock price. A positive inflow of volume has occurred if the line is above zero. If the line is below zero, a negative volume has occurred. The thick blue line represents a 55-day moving average of the volume line.

Corporate Events

This feature is available on daily and weekly graphs.

On the daily graphs, this feature displays the EPS % change for each quarter.

On the weekly graphs, this feature displays insider buy/sell transactions, dividend changes, public offerings, stock dividends or splits, repurchases and appointments of new CEOs.

Corporate Publications

This option will display, on a weekly WONDA graph, the source and date of an article featuring the company. Publications include Fortune, Business Week, Forbes and Barron's.

Disable Volume

This option will remove the volume display from any graph when the user clicks on the Disable Volume icon on the Graphic Options toolbar.
Display Daily Index

This function displays the performance, on daily graphs, of the index or O'Neil Industry Group used to plot the Relative Strength line. The default index is the S&P 500. To select a different index or industry group, bring up a graph of the desired index, click on the Data button and select the Use Index for Relative Strength option.

Display Weekly/Monthly Index

This function displays the performance, on weekly and monthly graphs, of the index or O'Neil Industry Group used to plot the Relative Strength line. The default index is the S&P 500. To select a different index or industry group, bring up a graph of the desired index, click on the Data button and select the Use Index for Relative Strength option.

Display Pos/Neg EPS Change

This function will display a percent change for EPS if EPS is positive or negative.

The formula used to calculate the EPS % change is as follows:

\[
\frac{(\text{Current Period EPS} - \text{Year Ago Period EPS})}{|\text{Year Ago Period EPS}|}.
\]

All EPS quarterly year-over-year percentage change calculations based on negative year-ago values will be flagged with a special character, #. Without this option checked, the method for comparing profitable earnings per share periods to unprofitable earnings per share periods was to flag this period with an N/A.

**EX:** Current Period EPS = $.10 and Year Ago Period EPS = -$.03  This Calculation:  \(\frac{(.10 - (-.03))}{.03} = 433\%\) Other Method: noted by N/A

Hi/Lo Points ($)

Displays high and low points on daily, weekly and monthly graphs. High and low price points are measured over a 19-period interval. For example, on a Daily graph, a high price point is marked on the date where there has been no higher price the nine days prior to that date and the nine days following that date. For volume, only high points are displayed. High volume points are measured over 25-period interval.

Hi/Hi & Lo/Lo Points (%) and Hi/Lo & Lo/Hi Points (%)

Displays percentage changes from the previous High to High and Low to Low or High to Low and Low to High Points. This feature must be used in conjunction with Hi/Lo Points ($).

Log Scale Volume

This option allows the user to display logarithmic volume on Daily, Weekly and Monthly graphs.
MACD Daily

Displays the MACD (moving average convergence divergence) graph on a Daily graph. The MACD options, such as the moving average periods and colors can be customized to fit your needs using the Graphic Options menu under Settings and selecting Daily Graph Options.

MACD Weekly/Monthly

Displays the MACD (moving average convergence divergence) graph on a weekly and monthly graph. The MACD options, such as the moving average periods and colors can be customized to fit your needs using the Graphic Options menu under Settings and selecting Weekly and Monthly Graph Options.

LLR/LLLCR

Leaders and Laggards Review are not part of the base package and require an entitlement. Please call your Account Executive at 800-545-8940 to discuss these entitlements.

This feature will display flags on daily, weekly and monthly graphs for stocks that are listed on the O’Neil New Leaders & Laggards Review Idea Services. The flag will appear pointing to the price node indicating the price of the issue and the point in time in which it was added. Once a company is removed, the flag will no longer appear on the graph.

NOTE: LLR/LLLCR flags will not print out on graphs.

Link Windows

This function will link all open graph windows together so one symbol will update all windows.

Relative Strength Index (RSI)

This option creates a Relative Strength Index (momentum) graph above the Daily, Weekly or Monthly graph.

The RSI is calculated with the following formula using 14 as the default number of periods (days, weeks or months).

\[
RS = \frac{\text{Summation of the price changes for up days ÷ 14}}{\text{Summation of the price changes for down days ÷ 14}}
\]

\[
RSI = 100 - \left[\frac{100}{1+RS}\right]
\]

RSI indicators can give the following signals that a trend may be ending:
1. Reaching an overbought or oversold reading.
2. Divergence is seen. A bearish divergence occurs when, at the end of a basing period, a new price high is not confirmed by the RSI. A bullish divergence is the inverse of this.
Stochastics

This option creates a Stochastics graph above Daily, Weekly and Monthly graphs. Stochastics indicators are intended for aid in spotting an overbought advance or an oversold decline.

The default formulas for %K and %D are as follows:

Raw Value = 100 X [(Last Close – 14 Period Low) / (14 Period High – 14 Period Low)]

New % K = (2/3) Previous % K + (1/3) New Raw Value

New % D = (2/3) Previous % D + (1/3) New % K

There are three indications that Stochastics can give to warn that a trend may be ending:

1. Reaching an overbought reading or oversold reading. This, however, can last for several periods before a meaningful change is seen.
2. %K crossing down over %D from an overbought level or %K crossing up through %D from an oversold level. At this point, the trend may still continue, so technical analysis of price becomes very important.
3. Divergence is seen. A bearish divergence occurs when, at the end of a basing period, a new price high is not confirmed by the stochastics. A bullish divergence is the inverse of this.

For additional information on interpretation of Stochastics Indicators, refer to Martin Pring on Market Momentum, (International Institute for Economic Research, 1993), or any publication on the analysis of market momentum indicators.

Always Auto-Fit

This option enables the Auto-Fit feature to always be enabled. Auto-Fit adjusts the graphs by 25% so that extreme high or low points are adjusted to be displayed in the graph.

Large Fonts

This option increases the font as well as the icons along the top of the graph.

Lock Track Price Position

This option allows the track price box to constantly be locked in the upper left-hand corner, regardless of the position of the crosshair.

Remember Fundamental Block (Auto Call)

This option allows the user to automatically pull up the Fundamental Block each time a Daily, Weekly or Monthly graph is selected.

Remember Sponsorship Block (Auto Call)

This option allows the user to automatically pull up the Sponsorship Block each time a Daily, Weekly or Monthly graph is selected.
Remember First Call Block (Auto Call)

This option allows the user to automatically pull up the First Call Block each time a Daily, Weekly or Monthly graph is selected.

Remember Quarterly/Annual (Auto Call)

This option allows the user to automatically pull up the Quarterly/Annual Block each time a Daily, Weekly or Monthly graph is selected.

NOTE: The Auto Call feature may also be used in conjunction with the list windows, allowing a user to scroll through and print out graphs containing the selected auto call items. The Fundamental and Quarterly Blocks will print out only on Weekly and Monthly graphs.

Statistics

This function will display the WONDA connection statistics for the current session.

Play Options

Play Mode

This option allows the user to manipulate the speed at which the graphs are displayed when scrolling through a list. It also allows the user to customize the view and/or print options for Daily, Weekly and Monthly graphs while in play mode of any list. For example, in order to automatically view the daily, weekly and monthly graphs of all the companies in a portfolio, select the daily, weekly and monthly boxes in the play mode and click OK. Once the settings are saved, clicking the play arrow on the portfolio list box will allow you to view the consecutive periods (daily, weekly and monthly) for each stock. In order to print the graphs for these consecutive periods, place a check in the Print field and then click on the play arrow.

Daily, Weekly and Monthly Graph Options

This option allows the user to customize moving average price lines on Daily, Weekly and Monthly graphs. Four simple moving averages (SMA) can be set on each graph, including the default moving average and three exponential moving averages (EMA). The default settings for the SMAs are as follows:

Daily Graph = 50 days and 200 days
Weekly Graph = 10 weeks and 40 weeks
Monthly Graph = 6 months

Each moving average can be customized by number of periods, pen size (line thickness) and color. The user may also add a moving average of each of the relative strength lines and adjust the specifications for the MACD as well as Stochastics/RSI.

Relative Strength Lines

This option allows the user specify the benchmark of the two Relative Strength Lines. The default benchmark for RS Line 1 is the S&P 500, and the default benchmark for RS Line 2 is the relevant Industry Group.
Section III: Menu Commands

**Colors**

This option allows the user to specify colors for certain parts of the graph.

**First Call Settings**

This option allows the user to choose the graphical display of the Thomson First Call® Earnings Estimate data. The Enhanced First Call feature is not part of the base WONDA package and requires an entitlement. For more information, contact your Thomson Reuters representative. You may also contact Client Services at 800-419-6632, or email support@williamoneil.com.

**Thomson Equity Settings**

This option allows the user to choose how the Thomson Equity data is displayed. The Thomson Equity Settings feature is not part of the base WONDA package and requires an entitlement. For more information, contact Client Services at 800-419-6632, or email support@williamoneil.com.

**Select Runner**

This option allows the user to choose the icon displayed when running a Custom Screen.

**Toolbars**

This option allows the user to select which tool bars will appear on screen as well as customize each toolbar with the desired icons. The following Tool Bar options are available:

For more information about the toolbars and icons, see Section II - Appendix C

**Prime Global Fundamentals**

This option allows the user to turn on or off certain features with the international database.

**Enable First Call**

Clicking on the Enable First Call option will change the earnings and estimate data on your graphs and within the blocks from William O’Neil + Co., Inc. data to Thomson First Call® earnings estimate data.
Update Data Monitor

This option provides added security for client Data Monitor(s) to ensure that securities are not inadvertently added or deleted from a Data Monitor or Analytical Perspective. In order to make changes to a Data Monitor or Analytical Perspective, the user must enable the Update Data Monitor option under the Options menu by placing a check mark next to it. When this option is enabled, the Add and Delete buttons appear in the Data Monitor window.

Note: Changes made to Data Monitors on WONDA will also appear in the weekly Data Monitor and/or Analytical Perspective printed service. Any changes made to the online Data Monitor prior to 8 p.m. PT on Thursday will be reflected in the next weeks printed Data Monitor or Analytical Perspective.

To disable this feature, remove the check mark from the Update Data Monitor option by clicking on it. The Add and Delete buttons will disappear from the Data Monitor window and the user will be unable to make modifications. Options regarding Data Monitor security are determined by each individual client, not William O’Neil + Co., Inc. As an added security measure, the Update Data Monitor entitlement can be removed by a Client Services Consultant. To enable this entitlement please call 800-419-6632.

Data Monitor and Analytical Perspective are not part of the base package and require an entitlement. Please call your Account Executive at 800-545-8940

Mark Line Graphs

This option allows the user to choose whether the Line Graph display contains a circle at the end of each interval denoting the closing price.

Dow Jones News Service® Alerts

This feature allows the user to set Dow Jones news alerts for any stock, Portfolios, Lists or Data Monitors.

Dow Jones News Service® is not part of the base package and requires an entitlement. Please call your Account Executive at 800-545-8940 for more information.

Sectors

Sectors are not part of the base package and requires an entitlement. Please call your Account Executive at 800-545-8940 for more information.

This feature is designed to simplify economic sector and industry comparative analysis by dividing the market into 11 broad sectors, which are then divided into 89 industries. The equity universe for the Sectors service is reduced to approximately 1,400 stocks, which comprise the Composite Index. These stocks fit the market capitalization and liquidity factors of most institutional investors. The leading stocks within the market (based on Relative Strength and Accumulation/Distribution Ratings) makes up one list. This list contains anywhere from 300 to 800 companies depending on the breadth of market leadership. The second list is primarily comprised of large capitalization, domestic growth companies that are regarded by William O’Neil + Company as having above-average investment potential.
Sector Lists

Users can view the breakdown of the Composite into Major Sectors and the O'Neil 89 Industries by clicking on the Lists icon on the Graphic Options Toolbar.

This opens a dockable window on the left-hand side of the display. Users can expand or collapse the Sector breakdown by clicking on the corresponding + or – button in front in the sector/industry name. Double-clicking on the name of the sector/industry will load the corresponding graph.

O’Neil Sectors Menu

Users entitled to the Sector feature will have a Sectors menu available in WONDA. To activate this feature, select the Initiate Sector Menu option from under the Sectors Menu.

This action opens the O'Neil Sectors feature, which is comprised of the three screens: Sectors screen, 89 O'Neil Industries screen and the Graph screen. The three screens work interactively—clicking on a button in one will automatically update applicable data in the other screens.
Section III: Menu Commands

Sectors Screen

This screen is located in the upper left-hand corner of the display. It provides the breakdown of the Composite Index into macro and major sectors (connected by lines). Clicking on a macro or major sector will display the sector’s relative weighted and un-weighted values in the S&P 500, the O’Neil Lists. This action will also update the Graph screen with the corresponding macro or major sector.

89 O’Neil Industries Screen

This screen is located in the upper right-hand corner of the display. It provides a further breakdown of the 11 Major Sectors into 89 O’Neil Industries. The numbers adjacent to the 89 industries designate the corresponding Major Sector that the industry belongs to. For example, the number 1 is the Major Sector number for Basic Materials. Basic Materials can be broken down into the following major industries: Agriculture, Chemical, ChemSpcity, Mining, PrecsMetal, PaperPdts and Steel.
Clicking on any of the 89 O’Neil Industry buttons will display that industry’s relative weighted value within the S&P 500. Other pertinent information, such as the top 5 stocks by improving Datagraph Rating, is also displayed in the Sector window.

In addition, clicking on any of the 89 O’Neil Industries buttons will update the Graph screen with the corresponding industry.
Section III: Menu Commands

Graph Screen

The Graph screen is located in the lower left-hand corner of the display. This screen plots a graph when any of the sector/industry buttons are selected.

To view the companies that comprise the sector or industry currently being graphed, select the name of the sector/industry under the Data button.

Alternatively, the user can access the list of components by clicking on the sector/industry link that appears in blue font below the symbol field.

A window will appear containing the companies that comprise the sector/industry.
Performance

The Performance option allows the user to view the O’Neil Rankings for each of the 89 Industries by changing the color of the tiles to reflect each industry’s ranking. The Performance Ratings key is located at the bottom of the 89 Industries screen.

Accumulation/Distribution

Selecting this option color codes each of the 89 industry groups on the right side of the screen according to its Accumulation/Distribution Letter Rating. Each industry group is ranked according to a letter rating and corresponding color:

Blue = A
Black = B
Green = C
Orange = D
Red = E

Industry Group Rank

Selecting this option color codes each of the 89 industry groups on the right side of the screen according to its Industry Group Rank. Each industry group is ranked according to a numerical value and corresponding color:

Blue = 1-19
Black = 20-36
Section III: Menu Commands

Green  = 40-59
Orange = 60-79
Red    = 80-89

Datagraph Rating

Selecting this option color codes each of the 89 industry groups on the right side of the screen according to its Datagraph Rating. Each industry group is ranked according to a numerical value and corresponding color:
Blue   = 99-81
Black  = 80-61
Green  = 60-41
Orange = 40-21
Red    = 20-1

EPS Rank

Selecting this option color codes each of the 89 industry groups on the right side of the screen according to its EPS Rank. Each industry group is ranked according to a numerical value and corresponding color:
Blue   = 99-81
Black  = 80-61
Green  = 60-41
Orange = 40-21
Red    = 20-1

Relative Strength Rating

Selecting this option color codes each of the 89 industry groups on the right side of the screen according to its Relative Strength. Each industry group is ranked according to a numerical value and corresponding color:
Blue   = 99-81
Black  = 80-61
Green  = 60-41
Orange = 40-21
Red    = 20-1

Weighted Industry Performance

This feature allows the user to view daily lists of securities meeting specific trading criteria. The lists are based on the 89 Industries that are compiled from The William O'Neil + Co. 197 industry Groups. To access the Weighted Industry Performance Lists, choose this option from the Sectors menu.

Note: Lists are updated every 15 minutes.

To view a performance list, highlight the desired list and select the Open button.
**89 Ind. Performance List**
Displays the performance of all 89 O'Neil Industries over a variety of time periods. Index Value and Group Rank are also provided.

**Bottom Ten: 89 Ind. Intraday**
The ten O'Neil Industries with the largest percentage drop in value from the previous day. Indices are market capitalization weighted.

**Bottom Ten: 89 Ind. Weekly**
The ten O'Neil Industries with the largest percentage drop in value from the value five days ago. Indices are market capitalization weighted.

**Top Ten: 89 Ind. Intraday**
The ten O'Neil Industries with the largest percentage gain in value from the previous day. Indices are market capitalization weighted.

**Top Ten: 89 Ind. Weekly**
The ten O'Neil Industries with the largest percentage gain in value from the value five days ago. Indices are market capitalization weighted.

**Close Sector Menu**
To exit the Sector feature, choose the Close Sector Menu option from the Sector menu. This option will bring the user back to the graph window.
Commentary

Market Overview

This feature allows the user to view the most recent Market Overview Commentary. Market Overviews are titled according to the date they are written. Historical Market Overviews are listed on the left side and are available by clicking on the hyperlink.

New Leaders & Laggards Highlights

This feature allows the user to view all the new Leaders & Laggards Highlights. The highlights are titled according to the company name and the respective list they have been added to. All available Leaders & Laggards Highlights are listed on the left by date with the most recent at the top, and are available for viewing by clicking on the title.

New Leaders & Laggards Large-Cap Highlights

This feature allows the user to view all the new Leaders & Laggards Large-Cap Highlights. The highlights are titled according to the company name and the respective list they have been added to. All available Leaders & Laggards Large-Cap Highlights are listed on the left by date with the most recent at the top, and are available for viewing by clicking on the title.

Gallery of Stock Market Winners

This feature allows the user to view the Gallery of Stock Market Winners. The gallery covers stocks that have had tremendous runs and the patterns they were showing prior to those runs.

Window Menu

The Window menu allows the user to open, display and arrange windows within WONDA.

New Window

Opens a new window for graphs. The new window will appear on top of the active window.
Tile Vertical/Horizontal/WONDA Tile

Tiles multiple windows. A list of open windows appears at the bottom of the Window menu with a check mark next to the active window.

Cascade

Cascades all open windows. A list of open windows appears under the Window menu with a check mark next to the active window.

Next

Brings up the next active window. This performs the same function as Up Arrow on the Browser Toolbar or by clicking on the Control and Tab keys on the keyboard.

Reposition Toolbars

This function allows the user to reposition the toolbars to the default setting after toolbars have been stacked or moved within the graph window.

Reset Toolbars

This function allows the user to reset the toolbars to the default setting after toolbars have been stacked or moved within the graph window.

Show/Hide Status

Gives the user the choice of monitoring current online status. To disable this function, click on the Show/Hide status option under the Window menu.

Active Window List

The list of current WONDA® windows appears in the bottom portion of the Window menu. The active window will have a check mark next to it.

Help Menu

How to Read the Blocks

Fundamental Block/Earnings Block/Sponsorship Block

This option helps the user read the Fundamental Block and the Earnings Block. Definitions and/or calculation formulas appear as the user scrolls over specific data points.

Screencast Index

This option takes the user to a list of all available WONDA Screencasts. WONDA Screencasts are short video-based tutorials that show the user where to find and how to use features within WONDA.
WONDA Manual
This option opens a pdf version of the WONDA Reference Manual.

Download WONDA Release
This option takes the user to the WONDA download page. This page allows the user to download the most recent versions of WONDA and WONDA Vantage.

Release Bulletins
This option takes the user to a webpage that lists the dates of the recent WONDA version releases.

Additional Services
This option takes the user to a webpage that describes our Institutional Services.

About WONDA
This option displays a pop-up box listing the version of WONDA that is currently being used.

Terms and Conditions
This option takes the user to a webpage that details the terms and conditions for WONDA.

WONDA Message
Used by Client Services to send broadcast messages regarding the WONDA service.

Client Feedback
This option takes the user to a webpage that allows them to provide feedback and submit requests.
IV. Custom Screens

Preset Custom Screens

Preset custom screens were formulated to provide users with quick access to reports that utilize many of the unique aspects of the O'Neil Database. They cover many different investing principles and also provide screening templates that can be easily adjusted to fit each user's customized needs.

Running a Preset Custom Screen

The preset custom screens are located in the lower half of the Custom Screen menu. To run a preset screen, simply click on the name of the screen. While the screen is running, the following items appear in the active window.

The custom screen runner icon appears in the window. To cancel the screen, click on the Cancel button.

The Custom Job Scheduled message appears in lower left-hand corner of the window.
This message indicates that the screen is being processed.

When the screen is finished running, a message window will appear indicating the number of stocks selected for the custom screen report.

To view the list of stocks selected by the screen, click the Get Report button. Selecting the Run Status button generates a status report that displays the cumulative number of stocks in the O'Neil Database that meet the selection criteria of the preset custom screen. To exit this message box, click on the Close button.

**Viewing Preset Criteria**

The selection criteria for each preset screen can be viewed and/or modified by the user. In order to accomplish this, select the Open Custom Screen option from the Custom Screen menu. This action opens the custom screen list window.

Select the Open Preset button to view the list of the preset screens.

Click on the name of the preset screen to be viewed or edited so that it is highlighted. Next, click on the Open As button. The program will prompt the user for a screen name. Once the name has been entered, click on the OK button.
The custom screen interface will appear. The preset criteria appear as logical statements (in blue font) in the lower half of the selection criteria tab. A criterion can be edited by highlighting the statement, modifying it and then clicking on Change button. To delete a criterion, highlight the statement and select the Delete button.

To modify the items that appear in the report, click on the Report tab in the upper left-hand corner of the custom screen interface. The report items appear in blue font in the lower half of the report tab. The user may customize the preset report by adding or deleting items.
To exit the preset screen and save any changes, click on the OK button. To run the modified preset screen, click on the Save & Run button. To exit without saving changes, click the Cancel button.

Available Preset Custom Screens:

<table>
<thead>
<tr>
<th>CANSLIM</th>
<th>Earnings Surprises -- Current and Prior Day (Priorday)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Companies Reporting This Week (Earndue)</td>
<td>Earnings Surprises -- Current and Last 5 Days (Last5Day)</td>
</tr>
<tr>
<td>Top Companies in Top Industries (Industry)</td>
<td>Top Performing IPOs - 2 Years (Upipos)</td>
</tr>
<tr>
<td>Recent New Issues (IPO)</td>
<td>Value</td>
</tr>
<tr>
<td>Sales and Earnings (Sales)</td>
<td></td>
</tr>
</tbody>
</table>
CAN SLIM

CAN SLIM is an acronym based on the William O'Neil investment philosophy. Each letter represents one of the chief characteristics of this investment strategy.

C - Current Quarterly Earnings Per Share

A - Annual Earnings Increases

N - New Products, New Management, New Highs

S - Supply and Demand

L - Leader and Laggard

I - Institutional Sponsorship

M - Market Direction

CAN SLIM Preset Criteria:

- $EIQY GEQ 25$ - Earnings per share % change, latest qtr vs. same qtr prior year $\geq 25\%$.
- $EIIY GEQ 20$ - Earnings per share % change, trailing 4 qtrs vs. same qtrs prior year $\geq 20\%$.
- $STABIL LEQ 25$ - Earnings Per Share Growth Rate Stability Factor $\leq 25\%$.
- $EPSRNK GEQ 80$ - Earnings Per Share Rank $\geq 80$.
- $ADNM GEQ 20$ - Accumulation/Distribution Number Rating $\geq 20$.
- $RLST GEQ 70$ - Relative Strength Ranking $\geq 70$.
- $GRPRNK LEQ 50$ – Industry Group Ranking $\leq 50$.
- $NOINST GEQ 10$ - Institutions holding position (number of inst.) $\geq 10$.
- $PRICE GEQ 8$ – Price, Last Close – 1 Day Ago $\geq $8.
- $AVOL GEQ 10000$ – Volume, Avg Daily Volume Last 50 Days – Cur Week $\geq 10,000$.

Companies Reporting This Week (Earndue)

Earndue Preset Criteria:

- Custom Calculation - UPCOME $DUETDC$ - PRITDC - Earnings due date (TDC) - current price date (TDC).
- Custom Calculation - POSITI $QEPES1 GEQ 0$ OR $QEPES1 LSS 0$ - Quarterly estimates for next reported quarter are $> 0$ or $< 0$.
- $UPCOMLEQ 5$ - Uses custom calculation to determine all companies with earnings due date within 6 trading days from current price date.
- $UPCOMQE 0$ - Uses custom calculation to determine all companies with earnings date at least 1 trading day after the current price date.
- $POSITI EQL 1$ - Setting the custom calculation $= 1$ makes it a true statement. It will use the custom calculation to find all of the quarterly estimates. This will eliminate all companies that do not have recorded estimates.
- $ERNDUE GTR 0$ – Date that the next EPS is due to be reported $> 0$. 
Top Companies in Top Industries (Industry)

Industry Preset Criteria:

- **GRPRNK LEQ 20** – Industry Group Ranking ≤ 20.
- **GRPRNK GTR 0** – Industry Group Ranking > 0.
- **RLST GEQ 75** - Relative Strength Ranking ≥ 75.
- **EPSRNK GEQ 75** - Earnings Per Share Rank ≥ 75.
- **MKTVAL GEQ 100000000** - Market value ≥ $100,000,000.
- **EIYY GEQ 25** -Earnings per share % change, trailing 4 quarters vs. same quarters prior year ≥ 25%.
- **SIYY GEQ 25** -Sales % change, trailing 4 quarters vs. same quarters prior year ≥ 25%.

Recent New Issues (IPO)

IPO Preset Criteria:

- Custom Calculation -RECENT
- **PRITDC - NEWTDC LEQ 40** - Current price date (TDC) - new issue date (TDC) going back 40 trading days.
- **RECENT EQL 1** - Setting this custom calculation = 1 makes it a true statement. This will determine all companies that were new issues within the last 40 trading days (or two months).
- **PRICE GEQ 5** - Price, Last Close – 1 Day Ago ≥ $5.

Sales and Earnings (Sales)

Sales Preset Criteria:

- **SIYY GEQ 25** -Sales % change, trailing 4 quarters vs. same quarters prior year ≥ 25%.
- **SIQY GEQ 30** - Sales % change, latest quarter vs. same quarter prior year ≥ 30%.
- **EIQY GEQ 25** - Earnings per share % change, latest quarter vs. same quarter prior year ≥ 25%.
- **EIYY GEQ 30** -Earnings per share % change, trailing 4 quarters vs. same quarters prior year ≥ 30%.
- **MKTVAL GTR 100000000** - Market value > $100,000,000.
- **EPSRNK GEQ 80** - Earnings Per Share Rank ≥ 80.
- **SALGRT GEQ 20** - 5 Year Sales Growth Rate ≥ 20%.
- **GROWTH GEQ 20** - 5 Year Earnings Growth Rate ≥ 20%.

Earnings Surprises - Current and Prior Day (Priorday)

Earnings Surprises - Prior Day Preset Criteria:

- Custom Calculation - YESTPR **PRITDC – 1** - Current price date (TDC) - 1.
- Custom Calculation - POSTIV **QEP GTR 0 or QEP LSS 0** - Earnings per share estimate for current quarter > or < 0.
- Custom Calculation - PERCEN
- **QESPC GEQ 0 or QESPC LSS 0** -Earnings per share estimate vs. actual for current quarter > or < 0.
- **YESTPR LEQ ERNTDC** -Uses custom calculation to determine all companies with a report date within the previous trading day.
- **POSTIV EQL 1** -Setting this custom calculation = 1 makes it a true statement. This will eliminate any companies that do not have recorded estimates.
- **PERCEN EQL 1** -Setting this custom calculation = 1 makes it a true statement. This will
eliminate any companies that do not have recorded estimates or earnings.

- **ERND EQL 0** – Setting this item = 0 makes it a false statement. This will exclude any stocks that have non-recurring items in the last reported earnings per share.

**Earnings Surprises – Current and Last 5 Days (Last5Day)**

Earnings Surprises - Last 5 Days Preset Criteria:

- Custom Calculation - FIVEDPR **PRITDC – 5** -Current price date (TDC) - 5.
- Custom Calculation - POSTIV **QEP GTR 0 or QEP LSS 0** - Earnings per share estimate for current quarter > or < 0.
- Custom Calculation - PERCEN
- **QEESPC GEQ 0 or QEESPC LSS 0** -Earnings per share estimate vs. actual for current quarter > or < 0.
- **FIVEDPR LEQ ERNTDC** -Uses custom calculation to determine all companies with a report date within 4 trading days from current price date.
- **POSTIV EQL 1** -Setting this custom calculation = 1 makes it a true statement. This will eliminate any companies that do not have recorded estimates.
- **PERCEN EQL 1** -Setting this custom calculation = 1 makes it a true statement. This will eliminate any companies that do not have recorded estimates or earnings.
- **ERND EQL 0** – Setting this item = 0 makes it a false statement. This will exclude any stocks that have non-recurring items in the last reported earnings per share.

**Top Performing IPOs - 2 Years (Upipos)**

UpIPOs Preset Criteria:

- Custom Calculation - RECENT
- **PRITDC - NEWTDC LEQ 520** -Current price date (TDC) - new issue date (TDC) going back 520 trading days.
- **RLST GEQ 80** -Relative Strength Ranking ≥ 80.
- **SIYY GEQ 25** -Sales % change, trailing 4 quarters vs. same quarters prior year ≥ 25%.
- **EIYY GEQ 25** -Earnings per share % change, trailing 4 quarters vs. same quarters prior year ≥ 25%.
- **RECENT EQL 1** -Setting this custom calculation = 1 makes it a true statement. This will search for all companies that were new issues within the last 520 trading days (or two years).

**Value**

The following criteria are set for the Value Preset Screen (includes some criteria used by Benjamin Graham):

- Custom Calculation - **PRICBK (PRICE / PSBKVL)** -Current price divided by book value per share.
- **PRICBK LEQ 2** – Price to book value less than or equal to 2.
- **EPER LEQ 15** – Estimated price to earnings ratio less than or equal to 15.
- **EPER GTR 0** – Estimated price to earnings ratio greater than 0.
- **PRERN LEQ 15** – Current price to earnings ratio less than or equal to 15.
- **PRERN GTR 0** – Current price to earnings ratio greater than 0.
- **PEQSP5 LSS 100** – Price to equity ratio vs S&P500 price to equity ratio less than 100 percent.
- **PEQSP5 GTR 0** – Price to equity ratio vs S&P500 price to equity ratio greater than 0.
- **GRT3YR GTR 15** – 3-Year Earnings Per Share Growth Rate greater than 15%.
- **SGR3YR GTR 15** – 3-Year Sales Growth Rate greater than 15%.
Creating a New Custom Screen

Custom screens allow the user to search the O’Neil Database for stocks meeting specific criteria. Additionally, users can create custom reports that retrieve fundamental and technical data for specified stocks or lists of stocks. The O’Neil Data Dictionary contains over 40,000 data items that can be used in custom screens and reports.

There are two steps involved in building a custom screen:

- Setting up the Selection Criteria
- Setting up the Custom Screen Report Items

Setting up the Selection Criteria

From the custom screen menu, select Open Custom Screen.

To create a new screen, select the New button and enter a name for the screen. To open an existing custom screen, highlight the name of the screen and select the Open button.

Once a new screen has been named or an existing screen has been opened, the Custom Screen interface will appear. This interface allows the user to narrow down the O’Neil Database of stocks through the use of selection criteria. Selection criteria are logical statements constructed from the data items listed in the Data Dictionary. These data items are given values through the use of relational operators. To properly set up a selection criterion, an O’Neil screening item must always be followed by 1) a relational operator, and 2) either a whole number, date or another data item.
Section IV: Custom Screens

Data Dictionary

The Custom Screen interface lists all the items available in the Data Dictionary. The user may locate items in the Data Dictionary by taking any of the following actions.

- To view all available items, select All Data Items and scroll down the list using the arrow buttons along the right-hand side of the window.
- To add historical items right-click on the item to bring up a window with the historical items.
- To select a specific date for an item that has history, click on the Use Calendar field and then right-click on the item to be used. Note: The date is not static and will move forward the following day, etc.
- To search for items in a specific category, click on the category button such as O'Neil Ratings, Dividends, etc.
- To search for a specific item, place the cursor in the field above the list of screen items.

Begin typing in the name of an item. The list will narrow as more of the letters and words of the description are typed. Once the desired item is located, highlight the item and the corresponding symbol will appear to the left of the relational operator field. The item definition will appear in the box below the list of screen items.
Relational Operators

After locating an item in the Data Dictionary, the user must select a relational operator followed by a whole number, date or another data item in order to complete the logical statement. The following relational operators are available.

Equal to (=) EQL
Greater than or Equal (≥) GEQ
Greater than (>) GTR
Less than or Equal (≤) LEQ
Less than (<) LSS
Not Equal to (≠) NEQ

The default relational operator is EQL or equal to. To change the operator, click on the down arrow adjacent to the EQL and select the desired operator.

Inserting Selection Criteria

In order to complete the logical statement and add a selection criteria to the screen, the user must insert a whole number, date or another data item in the field to the right of the relational operator. Once the statement has been completed, click on the Insert button. As each statement is added, it will appear in blue font in the lower half of the interface.
For example, to see a list of stocks with a market value of $500 million or more, the logical statement should be: market value greater than or equal to $500,000,000. This statement can be entered into the custom screen interface by using the Data Dictionary and relational operators. The corresponding selection criterion is: MKTVAL GEQ 500000000.

**NOTE:** When typing in selection criteria, a B may be entered for billion, M for million, and T for thousand. Alternatively, a comma (,) can be substituted for one thousand (000).

In addition, to see stocks with a current price greater than the price one week ago, the corresponding selection criterion reads: PRICE GTR PRICE5.

To delete a criterion from the list, highlight the item and select the Delete button. To make a change, highlight the item, modify it and then select the Change button.

**Custom Formulas**

This selection allows the user to create and use customized formulas (available in both the selection criteria and the report areas) using the items in the Data Dictionary. To create a formula, select the Custom Formulas button to open the Custom Calculations interface. Create a name for the formula in the Calculation Name area. Next, create the custom formula by using desired custom screen items found in the dictionary.
Creating Formulas

After naming the custom calculation, the user must enter the desired calculation in the Formula field. Formulas are written as equations using the following keys on the keyboard: + (addition), - (subtraction), * (multiplication), / (division). The parenthesis () are used to group equations. MIN, MAX, AND, and OR functions can also be used in custom calculations. The following are some examples of custom formulas:

- To calculate the average Five-Year Earnings Growth Rate over the past three years, these three figures would need to be added together and then divided by three. The formula would be written as follows:

\[(GROWTH + GROWTH1 + GROWTH2)/3\]

- To calculate the current fiscal year sales per share figure, divide sales by the number of shares outstanding. The formula would be written as follows:

\[SALF/CAPTL\]

- To select all stocks with the minimum earnings per share percentage change for the last 8 quarters, the user can write a custom formula using the EPS percentage change (EIQY) combined with the Minimum function. The formula would be written as follows:

\[\text{MIN}(EIQY, EIQY1, EIQY2, EIQY3, EIQY4, EIQY5, EIQY6, EIQY7)\]

To screen out stocks with less than a 20 percent change over the past two years, set this calculation to greater than or equal to 20 in the selection criteria interface.

- The calculation used to select a variable to the \( n \) power (an exponential value):

\[\text{PRICE}^n = \exp(n \times \log(\text{PRICE}))\]

- It is possible to construct if/then statements using custom formulas. For example, to select all stocks with a price greater than $15 the formula would be written as follows:

\[\text{CASE WHEN } (\text{PRICE0 GTR 15}) \text{ THEN 1 ELSE 0 END}\]

Set this formula equal to one on the selection criteria tab. Note: Setting a custom formula equal to 1 means that the result of the formula is true. Therefore, all stocks meeting this criterion will appear in the report. Setting the formula equal to 0 means that the result is false and stocks that do not meet this criterion will appear in the report.

- The calculation used to select all stocks with a price greater than $10 AND Relative Strength greater than 80 OR all stocks with price greater than $7 AND Relative Strength greater than 90 would be written as follows:

\[\text{CASE WHEN } (\text{PRICE GTR 10 AND RLST GTR 80}) \text{ OR } (\text{PRICE GTR 7 AND RLST GTR 90}) \text{ THEN 1 ELSE 0 END}\]

Set this formula equal to one in the Selection Criteria interface.
After the calculation has been entered in the Formula field, select the Save button to save it. Use the Customize button to adjust the field size, scale and number of decimal places in the formula results. The user may create a heading for the custom formula by selecting the Calc Title button (if no heading is entered, the Calculation Name will be used as the heading). After making Calc Title or other customization changes click on the Save button again.

Once the all the formulas have been entered, select the Close button to return to the selection criteria tab. To use the custom formula, highlight the name of the formula, select the appropriate relational operator and complete the statement with a value or another data item.
Section IV: Custom Screens

To return to the Custom Calculations interface (to either create a new formula or modify an existing formula) click on the Custom Formulas button and then on the Create & Edit Formulas button.

Formulas used in the current custom screen appear in the Custom Calculations in Use area of the window (lower left-hand corner).
- To create a new calculation, enter Calculation Name and the corresponding formula and click on the OK button.
- To modify an existing formula, click on the calculation name. The formula will appear in the Formula field. Make the necessary changes and click on the Save button. The program will ask the user whether or not to overwrite the existing calculation. To save the changes, select Yes. To leave the calculation unchanged select No.

Custom calculations can be created in one custom screen and used in other custom screens. All custom calculations created by the user appear in the Saved Custom Calculations area of the window. To utilize one of these calculations, highlight the name and click on the Use Calc button. The calculation now appears in the Custom Calculations in Use area of the window and can be used in the current custom screen.

IV-14
Custom formulas can be deleted from either the Custom Calculations In Use or Saved Custom Calculations by highlighting the desired custom formula and clicking on the Delete button.
Screening Options

This area provides additional ways in which a user can narrow the universe of stocks in the O'Neil Database. Once an option is selected, the title will appear in blue font. Clicking on a screening option button will open that menu item.

Key Word Search

This selection allows the user to search the company description that appears in the Fundamental Block as well as the company news items for specific words. Click on the Key Word Search button to open the feature. Choose to include or exclude companies containing the word in the description or news, then enter the desired words or phrases and click on the Insert button. If more than one word or phrase is inserted, the program will use OR logic and search for those stocks that contain any of the words entered. To utilize AND logic simply join multiple words with the word AND. For example, enter “software and networking” to search for stocks containing all words.
After entering the desired words and/or phrases, click on the OK button to return to the Selection Criteria tab. The Key Word Search button now appears in blue font, indicating that this option is included in the selection criteria. Key Word Search window and click on the Delete button.

**Industry Groups**

This selection allows the user to limit the universe of stocks by including or excluding specific O'Neil Industry Groups. To use this feature, highlight the names of the desired groups in the Available Groups area and then click on the Select button. The groups now appear in the Selected Groups area.

Select one of the following options:

- **Include Selected Groups**—this option includes the selected O'Neil Industry Groups in addition to any other stocks included in the screening criteria (such as lists, portfolios or data monitors).
- **Limit to Selected Group**—this option will include only those stocks in the O'Neil Industry Groups selected.
- **Exclude Selected Groups**—this option excludes all stocks in the selected O'Neil Industry Groups.
- **Use O'Neil Industry Groups**—this option selects one stock from each of the 197 O'Neil Industry Groups. The stock that appears in the report is the largest company (based on market value) in the corresponding O'Neil Industry Group.
Once the changes have been entered, click on the OK button to return to the selection criteria tab. The Industry Groups button now appears in blue font, indicating that this option is included in the selection criteria. To remove industry group criteria from the screen, highlight the group(s) in the Selected Groups area of the window and click on the Deselect button.

**Include/Exclude, Add Stocks**

The Include/Exclude selection allows the user to limit the universe of stocks being screened by either limiting the screen to stocks listed, or by excluding the stocks listed. If the user wishes to pull several report items from the O’Neil Database on one or several stocks, this selection can be used as the only screen criteria.

For example, to pull several fundamental ratios on a specific stock, enter the stock symbol in the symbol field, make sure the Include Stocks button is selected and click on the OK button. The Inc/Exc, Add Stocks button now appears in blue font indicating that it is included in the selection criteria. The custom screen program will generate the ratios only for the stock entered in the Include Stocks field.

The Add Stocks selection allows the user to add a stock to a universe even if it does not meet all the criteria set up on the selection criteria tab.

To remove stocks from either Include/Exclude Stocks or Add Stocks, highlight the symbol in the corresponding window and select the Delete button. Select OK to return to the selection criteria tab.

**Portfolios/Data Monitors**

The Include/Exclude Portfolios or Data Monitors option allows the user to limit the universe of stocks being screened to include only specific portfolios or lists of stocks. Including one or more portfolios or Data Monitors limits the universe to the portfolios listed. Excluding one or more portfolios or Data Monitors includes all stocks in the O’Neil Database except for those contained in the excluded portfolios.

- Use Portfolio - This selection allows the user to select portfolios from the Portfolio Manager list to either include or exclude from the universe.
• Use File - This selection allows the user to select lists of either symbols or CUSIPs contained in a file located on the user’s pc or a local network drive to include or exclude in the Selection Criteria. If a file containing CUSIPs is used, place a check mark in the CUSIPs box.

Once the desired portfolios or files have been selected, click on the OK button to return to the selection criteria tab. The Portfolios/Data Monitors button will now appear in blue font, indicating that this option is included in the selection criteria. To remove portfolios or files from the selection criteria, select the name of the portfolio or Data Monitor and then select the Delete button.

The Include/Exclude Data Monitor option allows the user to include or exclude a Data Monitor from a custom screen. Data Monitors are not part of the base package and require an entitlement. Please call your Account Executive at 800-545-8940

Company Location

This selection allows the user to limit the universe to companies with headquarters located in specific countries, states or cities.

When using this feature, enter one or a combination of parameters (country, state or city). For example, to locate companies in Springfield, Illinois, the user should enter Springfield in the Cities tab and Illinois in the States tab. To find companies located in a specific state(s), select the desired state(s) on the States tab and leave the Cities tab empty.

Universe, Exch, Perf Lists

The Include/Exclude Universe selection allows the user to limit screening to a specific universe or to exclude several universes from the custom screen. The following universes are available:

S&P 500 *Russell 1000 Value® Index
Midcap 400 *Russell 2000 Growth® Index
ADR *Russell 2000 Value® Index
Option Stocks *Russell Midcap® Index
Small Cap 600 *Russell Midcap Growth® Index
Toronto 300 *Russell Midcap Value® Index
*Russell 1000® Index *Russell 2500® Index
Section IV: Custom Screens

*Russell 2000® Index     *Russell 3000® Index

*Russell 1000 Growth® Index

*Russell Indices are not part of the base package and require an entitlement.

The Include/Exclude Exchanges selection allows the user to limit screening to a one exchange or to exclude one or more of the following exchanges from a custom screen:

New York Stock Exchange
American Stock Exchange
NASDAQ

The Performance Lists option allows the user to include or exclude one of the following Performance Lists from a custom screen.

In addition, the Week in Review Lists* option allows the user to include or exclude one of the following Week in Review Lists from a custom screen. *Week in Review Lists are not part of the base package and require an entitlement.

Exclude Items

This selection allows the user to exclude the following:
Foreign Securities (Company headquarters located outside the US or Canada)
Canadian Securities (Company headquarters located in Canada)
Closed-End Funds (Excluded by default)

Save & Run
The Save & Run button saves changes made to the current screen and runs it against the entire O’Neil Database.

OK / Save
Saves changes made to the current screen and closes the custom screen interface.

Cancel
Closes the current custom screen without saving changes.

Help
Selecting this option opens the WONDA custom screen help menu.
Setting Up the Report

Once the selection criteria have been set, select the Report tab to select the items that will be displayed in the report.

![Custom Screen (TEST) window](image)

From the report tab, the user can select any of the options below.

- Report Items
- Copy Items
- Custom Formulas
- Report Limit
- Report Sorting
- Report Statistics
- Report Title

**Report Items**

This window allows the user to define the items that will appear on the custom screen report. All available items appear in the Data Dictionary. The user may locate items in the Data Dictionary by taking any of the following actions:
Section IV: Custom Screens

- To view all available items, select the All Categories button and scroll down the list using the arrow buttons or scroll bar to the right of the box containing the items.
- To search for items in a specific category, click on the desired category button such as Balance Sheet, Dividends, etcetera and scroll down the list using the arrow buttons.
- To search for a specific item, bring the cursor to the bar above the list of screen items. Begin typing the name of an item. The list will narrow as more of the letters and words of the description are typed.

Once the desired item is found, highlight the item and click on the Insert button (the user may also double-click on the desired item) and it will appear under Report Items in the lower half of the screen in blue font. The Item Definition field below the Data Dictionary displays a detailed description of each data item.

The user can add ranges of historical data to the report for any item in the Data Dictionary that has information stored for more than one time period. To utilize this feature, right-click on an item in the Data Dictionary. If applicable, the available time periods will load into a window to the right of the item. Select the range of desired items by using the Shift key in conjunction with the mouse. Click on the Insert button to add the items to the report.

To delete a report item from the list, highlight the item in the Report Items window and select the Delete button. To make a change, highlight the item in the Report Items window, select the item that will replace it using the Data Dictionary and then click on the Change button. The new item will replace the old item.

To change the order of the items in the report, highlight the item to be moved and then double-click on the item it will appear above.

The user may add up to sixty report items to the custom screen report.

NOTE: In order to generate a custom screen list accompanied by WONDA graphs, the report must contain SYMBOL and CONAME (these items appear in the report by default).

Copy Items

This option allows the user to copy all of the items that were used as selection criteria into the Report Items window. This feature saves the user a step by not having to select all of the same items twice. Additional report items may be added before or after the Copy Items button has been selected.

Custom Formulas

This area allows the user to add customized formulas into the custom screen report. Click on the Custom Formulas button to view a list of the custom formulas used in the custom screen. If no custom formulas are used in the screen, then clicking on the Custom Formulas button will open the Custom Calculations window where new custom formulas can be created or existing custom formulas can be selected. For more information on creating custom formulas, see Creating Custom Formulas previously in this section.

Report Limit
This option allows the user to limit the custom screen report to a specified number or percentage of stocks. Simply click on Report Limit and select the maximum number of stocks or the percentage of stocks to be returned in the report. The report will be limited to the designated stocks based on the First Sort selected in the Report Sorting option.

**Report Sorting**

- **First Sort** - This option allows the user to specify the order in which the stocks that have been screened will appear in the report. For example, if the user wishes to see the list of stocks displayed in order from largest to smallest market value, MTKVAL must be entered into the primary sort column, and the descending option should be checked.
- **Second Sort** - This area allows the user to specify the secondary order in which the stocks that have been screened will appear on the report. For example, if the user has set the first sort as appearing from largest to smallest EPS Rank, by setting the secondary sort to price, the list will be sorted by EPS Rank first, and within each rank, the list will be sorted by price.
- **Third Sort** - This area allows the user to specify a third sort in which the stocks that have been screened will appear on the report. For example, if the user has set the first sort as appearing from largest to smallest EPS Rank, the second sort to Relative Strength and the third sort to price, the list will be sorted by EPS Rank first, and within each rank, the list will be sorted by Relative Strength. Then, within each Relative Strength Rank, the list will be sorted by price.

![Sort Report](image)

**NOTE:** The user must choose items that appear in the report items window as sort items (the screen will return an error if any of the sort items do not appear in the report).

**NOTE:** When running a screen over a portfolio, it is possible to maintain the order of the stocks in the portfolio rather than using the First, Second or Third sorts in the Custom Screen. Simply remove the First, Second and Third Sort(s) from the screen and select OK. The screen can now be run against a portfolio without affecting the order of the stocks in the list. The user must go through this process each time the screen is run against the portfolio.

**NOTE:** The report items can be sorted after the screen is run. For detailed instructions on sorting report items, please see Sort the Report later in this section. For detailed instructions on portfolios, please see Section II.

**Report Statistics**
This option generates totals and averages for each of the items in the report.

- Report Totals - Displays the totals for each report item in the last line of the report.
- Report Averages - Displays the average value of each report item in the last line of the report.
- Average Only - Generates a one-line report containing only the average value for each item in the report.
- Report Median - Displays the median value for each report item in the last line of the report.

**Report Title**

This option allows the user to create a heading for the custom screen report. If no title is selected, the Report Title is the name of the custom screen.

After customizing the report, select the Save & Run button. This will save the custom screen, run it against all of the stocks in the O'Neil Database and generate the custom screen report. To save the screen without running it, select OK / Save button.
Running an Existing Custom Screen

Run Last

This option runs the most recently accessed custom screen. To use this option, choose Run Last under the Custom Screen menu. A message will appear indicating the custom screen has been scheduled and the custom screen runner will appear on the screen.

![Custom Screen Menu]

Run

To select a screen to run, select the Run option from the Custom Screen menu. A window will appear listing all the existing custom screens. Highlight the screen to be run and select the Run button. A message will appear indicating the custom screen has been scheduled and the custom screen runner will appear in the upper right hand corner of the screen.

The user may pull graphs while the custom screen is running. Once the screen is finished, a message box will appear indicating the number of stocks selected by the screen. To view the list of stocks, select the Get Report option on the message box. The report lists the stocks selected along with the chosen report items.
**Status**

If the screen has not selected any stocks (or has selected too many stocks), the user may select Run Status from the message box. This action will generate a status report that displays all of the selection criteria in the custom screen as well as the cumulative number of stocks that meet each criterion. The status report can help identify errors in the screen as well as parameters that are too loose or too restrictive. The user can then reopen the screen, modify it and run it again.

Status reports can also be accessed by selecting the Run Status option from the custom screen menu. This will bring up a list of available custom screens. Highlight the desired screen and click on the Run button. The most recently run status report maybe accessed by choosing the Status option from the custom screen menu.

<table>
<thead>
<tr>
<th>AD</th>
<th>Symbol</th>
<th>Description</th>
<th>Relational Operator</th>
<th>Second Symbol</th>
<th>Second Description</th>
<th>Cumulative</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreign Canada Closed-End Funds</td>
<td>RIC000</td>
<td>500 DAY AVG VOL (HUND)</td>
<td>GEQ</td>
<td>5000000</td>
<td>18</td>
<td>2742</td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC001</td>
<td>PRICE</td>
<td>LESS THAN 1 YEAR AGO</td>
<td>GEQ</td>
<td>10</td>
<td>1905</td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC002</td>
<td>MARKET VALUE (mil)</td>
<td>GEQ</td>
<td>500000000</td>
<td>1584</td>
<td></td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC003</td>
<td>PERC</td>
<td>FIRST CALL CUR PV</td>
<td>GTR</td>
<td>6</td>
<td>1030</td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC004</td>
<td>RELATIVE STRENGTH</td>
<td>GEQ</td>
<td>10</td>
<td>698</td>
<td></td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC005</td>
<td>ACCUM DIV # CUR WEEK</td>
<td>GTR</td>
<td>6</td>
<td>420</td>
<td></td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC006</td>
<td>ACCUM DIV # PAST WEEK</td>
<td>GEQ</td>
<td>10</td>
<td>247</td>
<td></td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC007</td>
<td>ACCUM DIV# UP CT</td>
<td>LEQ</td>
<td>5</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC008</td>
<td>ACCUM DIV# UP CT</td>
<td>GTR</td>
<td>6</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>User Selection</td>
<td>RIC009</td>
<td>FIRST CALL CUR PV NET %</td>
<td>GTR</td>
<td>10</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

For additional assistance with Custom Screens, call Client Services at 800-419-6632.
Sharing Custom Screens

Users can share any of their custom screens with other users at their firm. To share a screen, select the Open Custom Screen option from the Custom Screen menu. This opens the custom screen window.

Click on the name of the screen so that it is highlighted. Next, select the Share button. The share window will open containing the list of WONDA users available to share with.

*Note: WONDA Support appears in the list of available users to assist with troubleshooting and reviewing of screens as requested.*
Select the user to share with by highlighting the user name. Multiple users may be selected by holding down the Shift key on your keyboard as you click on the names. Once the desired names have been highlighted, select the Add button.

Users that the screen has been shared with appear in the Shared Users field. To remove a user from the Shared Users list, simply highlight the user name and select the Remove button. To return to the custom screen window, click on the Close button.

Screens that you have shared with other users are denoted with a hand under the file icon that is next to the screen name, while screens others have shared with you are denoted with a hand over the icon. Screens other users have shared with you appear in the custom screen window with the creator's name in the Shared By column.

Shared screens are read-only and can only be edited/modified by the creator. In order to make changes to a screen someone has shared with you, it must be saved to your user code. To accomplish this, open the screen and select the OK / Save button. The program will prompt you to save the screen as your own.
Using the Custom Screen Report

Once a screen has been successfully run and the user selects Get Report, the following options are available:

- Printing Options
- Sorting the Report
- Moving the Report Item Headings
- Viewing Graphs From the Report
- Merging the Report into a Portfolio
- Exporting the Report to Excel
- Filtering on the Report

**Printing Options**

To print the custom screen report, select the printer icon (located in the upper left hand corner of the Report window). This will print the list of stocks and all of the data items in the report.

To print an individual graph, double-click on any stock from the report list and the graph will draw in the background. Next, select the Print option from the File menu.

To print the graph of each company in the report list, check Print within the report window and then select the play button to scroll through the list. This will bring up each graph on screen and send it to the printer. The user can enable the Remember Fundamental Block (Auto Call) feature for Fundamental and Quarterly Blocks on Weekly graphs in the Graphic Options menu (Control F12) in order to print the data blocks on each graph.
NOTE: Company news will not print out with a graph. Also, Fundamental and Quarterly Block information may be printed only on the weekly graph. Annual blocks will only print on the monthly graph.

**Sorting the Report**

When the report was originally created, the user had the option of setting up the report to include a first, second and third sort. Alternatively, the user can sort the report without having to run the custom screen again by clicking on any of the report headings. Once a report heading has been clicked, all of the stocks on the report will be sorted according to that heading. Click once to sort in ascending order and twice to sort in descending order.

*NOTE: By holding down the shift key when sorting by column heading, the sort will always be descending. By holding down the control key when sorting by column heading, that heading will become the secondary sort.*

**Moving the Report Item Headings**

When viewing the report, the user may rearrange the columns of data that appear in the report. The report items may be moved by clicking on a heading, dragging and dropping it on top of another heading. Once the mouse button is released, the selected heading will be placed to the left of the heading where it was dropped. The headings and data will be rearranged accordingly.

To permanently change the order of the report items, the user must modify the custom screen by opening the screen and accessing the Report tab. The Report Items window lists the items that appear each time the report is generated. To move the location of a data item up (down) the list, highlight the item to be moved and then double-click the item it is to appear above (below). Click OK to save these changes.

**Viewing Graphs From the Report**

To view the graphs of the stocks listed in the report, either double-click on the company name in the report window or click on the company name once and then press the Enter key. Additionally, the user may use the space bar to advance through the list one stock at a time.

WONDA also allows the user to automate the process of viewing graphs using the play feature. To play through the list of graphs, click on the symbol of the first graph to be viewed and press the play button at the bottom of the report window. The report window will disappear and the program will begin scrolling through the graphs one at a time. While the report is in play mode, pause and stop buttons will be enabled on the browser toolbar.

To pause play mode, click on the pause button. This allows the user to study the graph and other data in greater detail. To resume play, press the pause button again. Once the program reaches the last company in the report, the report list will reappear. To exit the report list, click the Exit button on the bottom of the window.

To exit play mode at any time and return to the report, press the stop button, press any key on the
keyboard (except for the space bar or the Enter key) or click anywhere on the graph.

**Merging the Report into a Portfolio**

The user can merge the list of stocks in any custom screen report into a portfolio. To accomplish this, choose the Portfolios option from the Lists menu.

This action opens the Portfolio Manager. To create a new portfolio, select the Create button.

Next, the user will be prompted to name the new portfolio. Enter a name and select OK.

Once the portfolio is named, an empty portfolio window will appear. To merge a custom screen report into the empty portfolio, press down the Alt key on the keyboard and at the same time, left click on a stock in the report window. Then, drag the cursor into the blank white area in the empty portfolio window and release the Alt key and the mouse.
Note: While dragging from the report window to the portfolio window, make sure that the Alt key and mouse are selected during the entire process.

The program will bring up a message asking the user whether or not to merge the stocks in the report window into the portfolio window. Select Yes to this prompt.

All the stocks in the report will be merged into the newly created portfolio.

Exporting the Report to Excel

The user may export the custom screen report to Microsoft Excel (provided that the Excel software is available on the user’s pc) by clicking on the Excel icon located in the upper left-hand corner of the report window.
Filtering on the Report

This feature allows the user to use an existing custom screen to filter out stocks from a report that do not meet the desired criteria. To filter on the report, select an existing custom screen by clicking on the down arrow next to the screen list of the report window. Highlight the desired screen so that it appears in the screen list field. Next, click on the run button located to the left of the screen list.

This will run the custom screen against the stocks in the report. Once the custom screen has finished running, a message will appear stating how many stocks met the selection criteria. Click the Get Report button to view the list of stocks that were selected.

Previous Reports

The Previous Reports feature allows the user to view reports of custom screens that have been previously run without having to run the custom screen again. To access a report, select Previous Reports from the Custom Screen menu.
Locate the name of the desired Report, highlight the file name and select the Open button (or double-click on the file name).
V. Custom Data Block

The Custom Data Block (CDB) feature allows users to build their own blocks of information on individual stocks. Several blocks can be combined into a single, easy-to-read Custom Data Report. Blocks and Reports can be printed directly from WONDA or exported into Microsoft® Excel® spreadsheet software. Users can also incorporate their own custom calculations into Blocks and Reports and even share them with other WONDA users at their firm.

To access the CDB feature, click on the icon located in the toolbar. This will open the CDB window.
Custom Items

This section within the tree structure will display any previously created custom calculations, data blocks, as well as reports. Using this section, users can run, edit, preview or share items. If a description was created, it will appear in the gray box beneath the list of items.

Data Items

This section provides a list of data items to view in a block. The data item section is further broken down into sub sections containing both technical and fundamental information. Clicking on a data item sub category produces a subset of data items.

Items with the **H** icon indicate historical information is available for the data item. The historical information can be accessed by either double-clicking on the item, or by right-clicking and selecting history.

Items with the **I** icon indicate that only current information is available for the data item.

Once an item is highlighted, the item’s identifier (unique symbol) as well as a definition is available in the box below.

Preset

This section provides a list of preset Custom Data Blocks and Reports. Blocks include annual ratios, balance sheet and income statement information, O’Neil ratings and rankings, quarterly ratios, cash conversion ratios, leverage ratios, liquidity ratios, company overview information as well as valuation ratios.

Shared

This section displays Custom Data Blocks and Reports that have been shared by other users. In order to edit a shared block or report from another user, the user must resave the block/report under a different name. Any changes made to a shared block or report will be seen by all “shared with” users.
Favorites

This section allows the user quick access to frequently used data items, blocks or reports. To move an item into the favorites folder, locate the item and click and drag it into the folder.

Creating and Editing a New Custom Data Block

To create a new block, click on the icon located on the top left corner of the CDB interface. This will open the new block window where data items can be added and displayed. The user can also add a brief description of the contents of the block. Clicking the save icon automatically prompts the user to create a name for the block.

The interface shown above has most of the formatting functionality of a Microsoft® Excel® spreadsheet.
**Adding items to the New Block**

Using the Custom Items and Data Items tabs in the tree structure, search through the list to find the item to be viewed. **Left-clicking** and dragging the item will transfer the respective data item identifier (value to be viewed). **Right-clicking** and dragging the item into the new CDB window will transfer the data item description (definition). The user may also right click on the data item to copy the data item identifier or to copy the description. Historical information may also be accessed by double clicking on the data item, or by right clicking and choosing history.

**Note:** When the data item is added to the block, it is enclosed by pound signs `# #`. These are required for the block to run properly.

Custom Calculations previously created in the Custom Screens tool can be accessed in the box above the spreadsheet. Locate the custom calculation and right or left click and drag to the new CDB window to add to the block.

User may also type information into the new CDB. This can be used if you want to change the data item description or if you want to add any information that will be seen on the block. Double-click on the cell to get the cursor and begin typing.

**Sample Block – Editing Window**
While in editing mode, you have the option to preview the block by clicking on the icon. A sample block will display with the information chosen.

Once saved, the block can be accessed and can be run either by clicking on the icon, or by searching through the Custom Items section in the tree structure and double clicking the block name. Blocks are denoted with the icon.

**Running a Custom Data Block**

To run a block, search through the Custom Items section on the tree structure. Locate the block and double-click to run. The block will display information on the currently graphed company. As a new stock graph is pulled, the block will automatically refresh with the new stock’s information.
By clicking the Linked icon on the top of the CDB (changing the icon to Unlinked), the current block’s data will remain static and will not refresh when a new stock graph is pulled. The user has the option to export the block to Microsoft® Excel® spreadsheet software, edit the block, print and save as a favorite.

**Note:** Closing the Custom Data Block interface next to the WONDA graph will not remove the Custom Data Block that is open.

**Editing Existing Blocks**

The user can edit the Custom Data Block by locating the block in the Custom Items feature in the tree structure, right-clicking on the block, and choosing edit. Additionally, the user can edit an existing block by opening the block and clicking on the edit icon on the top of the block. The CDB window will appear with the information previously entered. The user can add, remove, and change information from this window.

**Creating and Editing a New Custom Data Report**

Reports are created by combining two or more Custom Data Blocks. When selected, the report will display the Custom Data Blocks in one window.

To create a new report, click on the drop down arrow on the new screen icon and select Report.
A new window will appear which will allow the user to click and drag Custom Data Blocks into a spreadsheet. The user can add a brief description of the contents of the report. Saving the report allows the user to create a name for the report.

Using the Custom Items section in the tree structure and locate the Custom Data Block to be viewed. **Left-clicking** and dragging the block will transfer the respective block’s data items to be viewed. **Right-clicking** and dragging the block into the new CDB window will transfer the block’s description into the spreadsheet.

**Note:** When the block is added to the report, it is enclosed by the @ signs. These are required for the report to run properly.

User may also type information into the new report. This can be used if you want to change the block description or if you want to add any information that will be seen on the report. Double-click on the cell to get the cursor and begin typing.

Preset Custom Data Blocks are available under the Preset tab in the tree structure. The user has the option to mix preset blocks with ones created by the user when creating a custom data report.
Sample Report – Editing Window

While in editing mode, you have the option to preview the report by clicking on the icon. A sample report will display with the information chosen.

Once saved, the report can be accessed and can be run either by clicking on the icon, or by searching through the Custom Items section in the tree structure. Reports are denoted with the icon.

**Running a Custom Data Report**

To run a report, search through the Custom Items section on the tree structure. Locate the report and double-click to open. The report will display information on the currently graphed company.
By clicking the Linked icon on the top of the report (changing the icon to Unlinked), the current report will remain static and will not refresh when a new stock graph is pulled. The user has the option to export the report to Microsoft® Excel® spreadsheet software, edit the report, print and save as a favorite.

**Note:** Closing the Custom Data Report interface next to the WONDA graph will not remove the Custom Data Report that is open.

**Editing Existing Reports**

The user can edit the Custom Data Report by locating the Report in the Custom Items feature in the tree structure, right-clicking on the report, and choosing edit. Additionally, the user can edit an existing report by opening the report and clicking on the edit icon on the top of the report. The Custom Data Report window will appear with the information previously entered. The user can add, remove, and change information from this window.
Sharing Custom Data Blocks and Custom Data Reports

Users have the option to share Custom Data Blocks and Reports with other users within the same firm. Locate the desired block or report using the Custom Items tab in the tree structure. Right click on the block or report and click share. A window will appear with available users to share with on the left hand side and the users currently shared with on the right hand side. To add a user, double click the user’s name on the left hand side or highlight the user and click add. To remove a user, double click the user’s name on the right hand side or highlight the user’s name and click remove.

When opening a Custom Data Block or Report that is shared from another user, the user must click ‘save as’ icon if changes are to be made to the block or report.

How to Add Custom Calculations

Users can create custom calculations using available data items. These calculations can then be displayed in blocks or reports.

Custom Calculations from the Custom Screens tool automatically show up in the Custom Data Blocks feature. Custom Calculations are accessed in the Custom Items feature in the tree structure. Calculations are denoted by .

To add a new custom calculation within the CDB feature, click on the drop down arrow for the new block icon and select Calc.
A window will appear allowing the user to create the custom calculation.

The user can write a brief description about the calculation. Headers are available so that the calculation can also be used in the Custom Screen tool. Custom Calculations work interchangeably in both the Custom Screen and Custom Data Block features.

The custom formula can be created in the formula box. Simply drag and drop the data items from the custom items category in tree structure. User can choose the field size, how many decimal places are displayed in the block as well as the scale factor.

**Note:** When the data item is added to the calculation, it is enclosed by pound signs `# #`. These are required for the calculation to run properly.

For more information on creating custom calculations, refer to Section IV.

### How to Add Custom Blocks or Reports to Favorites

Users have the ability to add Custom Data Blocks or Reports to their favorites list. To add as a favorite, open the desired block or report and click the **Favorite** icon. Accessing the **Favorite** icon on the top toolbar will open your list of favorites.

Users additionally have the option to add commonly used data items, blocks or reports to the CDB Favorites folder in the tree structure. This allows for quick access to certain data items when creating, opening or editing features within Custom Data Blocks.
To add a data item, block, or report, locate the item using the tree structure. Highlight the item and drag to the favorites folder.
VI. WONDA® Vantage

WONDA Vantage is a Microsoft® Excel® spreadsheet software Add-In that allows users to view pre-built templates and models or to build powerful reports, screens and financial models powered by the William O’Neil Premium Financials Database. It is accessible within Microsoft® Excel® spreadsheet software through the O’Neil Menu and the WONDA Vantage Toolbar.

This section will discuss WONDA Vantage’s functionality and how it works

- WONDA Vantage Toolbar Icons
- O’Neil Tab Features
- WONDA Vantage Formulas
- WONDA Vantage Data items

WONDA Vantage Toolbar Icons

The WONDA Vantage toolbar will appear in Microsoft® Excel® spreadsheet software after WONDA Vantage is installed from either the download website or a downloadable CD. After the installation, checkmark “WONDA Vantage” in Microsoft® Excel® spreadsheet software’s Add-in menu; If “WONDA Vantage” does not appear, browse to find the Vantage.xls and click add. This will enable the Vantage and the Toolbar Icons to work.
Report Builder

The Report Builder allows the user to create custom reports that retrieve fundamental and technical data from the William O'Neil Database for specified stocks or saved WONDA lists.

To access the Report Builder, click on the Report Builder icon , or on the O'Neil tab, scroll down to Reports, then click on Report Builder.

A window will display with three report building tabs: Ticker Selection, Data, and Layout.

Ticker Selection

Use the Ticker Selection tab to select which stocks are to be included in the report. A report may be created for a single stock or many stocks. Type the tickers into the Symbol box, or choose from the various categories on the left including stocks within certain industries, as well as stocks within a user’s specific list previously created in WONDA. Click the add button to include stocks in the report.
To remove stocks from the Report Builder, double click on the company listed under Selected Items, or highlight the stock and click the remove button. When finished, click the Next button.

**Data**

The *Data* tab allows the user to select the data to be presented in the report.

All available data items appear in the WONDA and Vantage Data Dictionary. The left side of the screen displays a tree structure with tabs to search for specific data items. The tab categories include: O'Neil, Favorites, Financial Statements, Corporate, and Analysis. Navigate through the tree diagram and scroll down the list using the arrow buttons.

The *Search* tab allows the user to search for a data item by typing the name in the search field and clicking search icon. Additional search options are available in a drop down menu to narrow a search.

The *All* categories tab lists all of the data items available in WONDA Vantage. To scroll down the list quickly, click on a listed data item and proceed to type the letters of the desired data item. A scroll bar is available on the right side of the box to navigate faster through a list.

Once the desired item is found, highlight the item and click on the Insert button and item will move to the right side under Selected Items. Double clicking on the desired item will move it to the report as well.

To remove a selected item, highlighting it and click on the remove button. Double click on the data item in the Selected Items window.
To change the order of the items in the report, highlight the item to be moved and click on the direction arrows [ and ] to place where the item will appear in the report.

When finished, click the Next button.

**Layout**

The Layout tab allows the user to decide how the data items will be displayed in the report. Choices include the frequency of the data, the number of periods displayed, the report view with layout options, and the location of the report within the Microsoft® Excel® worksheet.

The Preview window and the Zoom+ button provide quick previews of how the report will look. At any time, click the Back button to return to an earlier tab and make changes. When the desired layout view is ready, click the Run button. WONDA Vantage will generate the report and place it on the active Microsoft® Excel® worksheet with the top left corner placed in the Target cell.
**Report List**

All saved reports created in Report Builder are saved in the *Report List* feature.

To access the *Report Lists*, click on the *Report List* icon, or click on the *O’Neil* tab, scroll down to *Reports*, then click on *Report List*.

A window will appear with all previously created screens as well as a short description.

![Report List Window](image)

To run a report, highlight the report and click *Run*. Additional options include creating a new report, editing, renaming, or deleting an existing report. The additional options may be performed by highlighting the existing report and clicking on the corresponding button on the top toolbar.

**Screen Builder**

The Screen Builder allows the user to quickly filter through the *O’Neil* database and populate a list of companies that meet chosen criteria. The user may save screens and access them later through the *Screen List*. 
To access the Screen Builder, click on the Screen Builder icon or on the O'Neil tab, scroll down to Screening, then click on Screen Builder.

A window will display with three screen building tabs: Universe, Criteria, and Layout.

**Universe**

To narrow down the database to only include specific stocks to screen against, type the desired tickers in the Symbol box. To screen the entire O'Neil database against the chosen criteria, leave the Universe screen blank. Using the tree structure, the user may search for stocks within certain industries, stocks within certain indices, as well as stocks within a user’s specific list previously created in WONDA.

To add a list from the tree structure, either double click on the group or highlight the group and click Add. The added stocks will be featured in the Included Stocks window.
To exclude symbols in the *Included Stocks* window, enter the ticker into the Symbol box and select *Exclude*; the stock will appear in the *Excluded Stocks* window.

To remove a stock from either the included stocks list or the excluded stocks list, highlight the stock and click remove. When finished, click the Next button.

**Criteria**

The *Criteria* tab allows the user to select the criteria for the screen. The left side displays a tree structure with tabs to search for specific data items. The tab categories include: *O’Neil, Favorites, Calcs, Financial Statements, Corporate, and Analysis*. A Search tab is also available if the data item name or relevant category is not yet known. When a data item is highlighted in this section, the item definition will appear in the grey box below the tree structure.

The right hand side of the window displays the criteria selected. To add a selection criteria to the screen, the cursor must be active in the field to the left of the qualifier. Using the tree structure on the left, locate the desired data item and double click on the item. The item identifier will populate in the field on the right. Item identifiers in Vantage are the same identifiers as in WONDA. Select the operational qualifier in the drop down list. The user may add a number or another data item on the right hand side of the equation to finalize the selection criteria. When done, click the button to insert the criteria into the selection list. To delete a criteria, click the button.

Once criteria are added, the user may see the number of stocks that fit the criteria based on the universe selected. Click Refresh Stock Count to see the most updated number of stocks.
To have the option to select AND/OR criteria, click on the Advanced button. Selecting AND in the drop down bar will make each criteria row absolute. An OR selection will generate stocks that fit a certain criteria or another criteria.

**Layout**

The layout feature allows the user to decide which items will be displayed in the report from the stock list generated. The tree structure listing the available data items is located on the left. Different categories of data are available as well as a Search tab to search a data item by keyword. To add a data item within the report, locate the item on the left hand side. Highlight the data item and click Add, or double click the item. By default, Symbol and Company Name will appear in the report, and each successive item will be added to the bottom of the list. Click *Insert Criteria* to include screening data items from the Criteria tab. To move an item closer to the top or bottom of the list, highlight the item in the Display Items window and click the and arrows until the item appears in the desired place.

The user may select preset sorting criteria. To add a data item to the Sorting Options window, select the item in the Display Items window and click the double down arrow ; double clicking item in the Display Items window will also move it to the Sort Options window. Within the sorting list, click the drop down button to designate ascending (ASC) or descending (DESC) order for the item. To delete additional sorting options, click the delete button .
Additional options are available to designate a specific number or a specific percentage of stocks to be displayed. The additional options are located on the lower portion of the Layout tab. The target cell (which will become the top left corner of the report) is the correct cell corresponding with the Microsoft® Excel® spreadsheet. To change the cell, highlight the desired cell on the Microsoft® Excel® sheet and click the button on the screen builder window. The updated cell column and row will appear in the box.

To save the screen, click Save. To run the screen without saving, click the Run button.

Screen List

All saved screens created in Screen Builder are saved in the Screen List feature.

To access the Screen Lists, click on the Screen Lists icon or click on the O’Neil tab, scroll down to Screening, then click on Screen List.

A window will appear with all previously created screens as well as a short description.
To run a screen, highlight the screen and click Run. Additional options include creating a new screen, editing, renaming, or deleting an existing screen. The additional options may be performed by highlighting the existing screen and clicking on the corresponding button on the top toolbar.

**Add Data Item**

To add O'Neil database items to an *Microsoft® Excel®* worksheet, click the Add Data Item icon, or on the O'Neil tab and select Add Data Item.

Add Data Item Window will open with the left side of displaying a tree structure with tabs to search for specific data items.
All available data items appear in the WONDA and Vantage Data Dictionary. The left side of the window displays a tree structure with tabs to search for specific data items. The tab categories include: O'Neil, Favorites, Financial Statements, Corporate, and Analysis. Navigate through the tree diagram and scroll down the list using the arrow buttons.

The **Search** tab allows the user to search for a data item by typing the name in the search field and clicking search icon. Additional search options are available in a drop down menu to narrow a search.

The **All categories** tab lists all of the data items available in WONDA. To scroll down the list quickly, click on a listed data item and proceed to type the letters of the desired data item. A scroll bar is available on the right side of the window to navigate faster through a list.

Click on the desired data item. The data item’s identifier will be automatically populated in the **Data Item** field in the top right corner.

The right side of the window allows the user to select a ticker symbol, the frequency of the data, the number of periods displayed, the general layout, and the location of the data items within the active *Microsoft® Excel®* worksheet.

Click **Run** to add the data item to the worksheet.

**Auto Refresh**

When changes are made to a *Microsoft® Excel®* worksheet, the user is subsequently required to refresh the worksheet in order to view the most currently available data. With **Auto Refresh On**[^1], Vantage data will automatically update when a Vantage cell is modified.

Auto Refresh may be turned off by clicking on the **Auto Refresh** icon, or on the O'Neil tab and clicking on **Auto Refresh On**. The icon denotes that Auto Refresh is off.

If Auto Refresh is turned off, the worksheet needs to be refreshed manually. This may be done by clicking on the **Refresh Sheet** Icon.
O’Neil Tab Features

The O’Neil tab includes extra features in addition to the WONDA Vantage Toolbar’s functionality. This section will explain the additional features, including preset Vantage templates, models, a stock lookup functional and user settings menus.

Templates

WONDA Vantage contains pre-built templates for quick access to commonly-used information.

Access the Templates under the O’Neil tab by clicking on Templates.

A window of available templates will appear. Select the desired template and click open. Type company ticker into the yellow cell and hit the Enter key. Each template acts as an independent one-page printable sheet of information relative to a specific topic. Template topics include:

Company Overview

The Company Overview template provides a synopsis of the company’s performance. Along with a quick snapshot of the company’s WONDA Daily graph, other information is provided including the business summary, yearly, quarterly and weekly financial information, consensus estimates, O’Neil ratings and rankings as well as other financial valuations.

Comparison

The Comparison template allows the user to compare the statistics of a maximum of 10 companies. Comparison statistics include profitability analysis, leverage information, liquidity and efficiency, valuation, O’Neil ratings and rankings as well as price performance.

Dupont

The Dupont template provides analysis for a particular company’s basic income statement items on an annual basis. In addition,
annual information for a 3 stage traditional Dupont analysis and a 5 stage extended Dupont analysis are noted.

**Leverage**

The Leverage template focuses on a company’s debt and equity performance. Balance sheet debt and equity items are displayed on an annual basis along with leverage information in graphical form.

**Liquidity and Efficiency**

The Liquidity and Efficiency template provides information on annual cash levels, cash conversion cycles, turnover analysis, working capital analysis, and stock liquidity. The company’s cash conversion cycle, liquidity ratios and net cash per share data are available in graphical form.

**O’Neil Ratings**

The O’Neil Ratings template provides quick access to O’Neil ratings and rankings for a single company. Current ratings and rankings as well as historical trends are displayed. The WONDA daily graph will display as well.

**Profitability**

The Profitability template provides profitability information by displaying year-over-year income statement data, per share data, margin analysis, return analysis as well as cash flow analysis. Margin analysis and year-over-year income statement data are available in graphical form.

**Models**

Three different models are available within Vantage. These models allow the user to make assumptions about a company and project future results.

To access the models, click on the O’Neil tab, click Models, and select the model you wish to see. Type the company’s ticker into the yellow symbol field.
DCF

This model provides information on **Discounted Cash Flow** Assumptions. Historical income statement items are available as well as projected values based on assumed growth rates (as inputted by the user).

APV

This model provides information on **Adjusted Present Value** Assumptions. Historical income statement items are available as well as projected values based on assumed growth rates (as inputted by the user).

Dividend Discount

This feature provides information on a two stage **Dividend Discount** model. Expected figures are calculated for a high growth period as well as a stable growth period. The present value of dividends, terminal price and cost of equity information is provided as well.

Stock Lookup

To look up a stock symbol, access the **Stock Lookup** by clicking on the *O'Neil* tab and selecting **Stock Lookup**.

With the Stock Lookup window open, type a name into the *Name* entry field and select **Lookup**. Additional search options are listed below the name entry field and may be selected when looking up a stock symbol including

The results from the lookup will display in the window. The results will include stocks symbol, company name and type of security.

Click on the **Close** button to exit this function.
User Profile

To access the WONDA Vantage User Profile, click on the O’Neil tab and click on User Profile.

A new window will appear. Within this window, the user may change User Info settings as well as proxy settings.

To allow Vantage to automatically work when opening Microsoft® Excel® spreadsheet software, fill user’s pertinent User ID and Password information in the User Settings section. The User ID and password are the same ID and password to access WONDA.

Change Password

The user has the option to change their password. To access this feature, go to the O’Neil tab and click on Change Password.

A new window will appear prompting the user to type in the current password and choose a new one.

NOTE: Because WONDA and Vantage use the same login information (User ID and password), changing the password through Vantage changes the password to access WONDA as well.
WONDA Vantage Formulas

WONDA Vantage data items follow a general formula to access data from the William O’Neil Database into a Microsoft® Excel® worksheet. An example of the Vantage Formula is listed below:

=WON (“EPSRNK”, $A2, “W-2”)

- **Time period for data item.** See time period list below.
- **Cell Reference, Ticker in quotes “GOOG” can be entered.**
- **WONDA Vantage Data Symbol**
- **Tells Excel to bring in William O’Neil Data**

The following table lists the symbols for the time period reference for the WON formula:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;D&quot;</td>
<td>Daily</td>
</tr>
<tr>
<td>&quot;W&quot;</td>
<td>Weekly</td>
</tr>
<tr>
<td>&quot;M&quot;</td>
<td>Monthly</td>
</tr>
<tr>
<td>&quot;FA&quot;</td>
<td>Fiscal Annual</td>
</tr>
<tr>
<td>&quot;FQ&quot;</td>
<td>Fiscal Quarterly</td>
</tr>
<tr>
<td>&quot;CA&quot;</td>
<td>Calendar Annual</td>
</tr>
<tr>
<td>&quot;CQ&quot;</td>
<td>Calendar Quarterly</td>
</tr>
</tbody>
</table>
Examples of Vantage Formulas:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Relative Strength Rating - Weekly</td>
<td>Eps - Qtrly</td>
<td>Eps - Annual</td>
<td>P/ E Ratio - Current</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>11/28/08</td>
<td>9/30/08</td>
<td>12/31/07</td>
<td>12/11/08</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>ABC</td>
<td>60</td>
<td>0.39</td>
<td>1.26</td>
<td>11</td>
<td></td>
</tr>
</tbody>
</table>

= WON("PRERN",$A3,"D")

= WON("ERNF",$A3","FQ-1")

= WON("ERNQ",$A3,"FQ-1")

= WON("RLST",$A3,"W-2")

The user may access current, historical and estimate data items in the WONDA Vantage Data Dictionary. The Data Items are denoted by the following icons:

- **Yellow Sheet** - Indicates that the data item is available only for the current period.

- **Green Clock** - Indicates that the data item is available for the current period and historical periods. Number of available periods is noted in the data items definition.
  
  Add a minus sign to the time period symbol, followed by the number of periods going back. For example, "W-2" would be two weeks ago.

- **Pink Arrow** - Indicates that the data item is available for the current period and estimate periods. Number of available periods is noted in the data items definition.
  
  To get estimate data, add a plus sign to the time period symbol, followed by the number of available estimate periods. For example, "FQ+1" is the next fiscal quarter.
The historical time period may also be entered as an actual date. For example, “D-5/5/2005” would get the daily value as of May 5th, 2005.

**WONDA Vantage Date Formula**

The Vantage date formula allows a user to input a date into a Microsoft® Excel® worksheet. To input a date, set the cell to a date format and use the following formula:

\[
\text{=WONDATE(“FQ-1”)}
\]

The following table lists the symbols for the time period reference for the WONDATE formula:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;D&quot;</td>
<td>Daily</td>
</tr>
<tr>
<td>&quot;W&quot;</td>
<td>Weekly</td>
</tr>
<tr>
<td>&quot;M&quot;</td>
<td>Monthly</td>
</tr>
<tr>
<td>&quot;FA&quot;</td>
<td>Fiscal Annual</td>
</tr>
<tr>
<td>&quot;FQ&quot;</td>
<td>Fiscal Quarterly</td>
</tr>
<tr>
<td>&quot;CA&quot;</td>
<td>Calendar Annual</td>
</tr>
<tr>
<td>&quot;CQ&quot;</td>
<td>Calendar Quarterly</td>
</tr>
</tbody>
</table>

![Excel Worksheet Example]

```
=WONDATE("FA-1")
=WONDATE("CQ-1")
=WONDATE("W-1")
=WONDATE("D-1")
```
To get historical date, add a minus sign to the time period symbol and then the number of historical periods going back desired. For example, "D-1" would be one day ago.

To get future date, add a plus sign to the time period symbol and then the number of periods forward desired. For example, "FA+1" is the next fiscal year.

Optional Format

A user is able to pull a time period date for a specific stock. For example, to enter the current fiscal quarter end date for LTD, enter the following formula:

```
=WONDATE("FQ",A2)
```

The following formula tells Microsoft® Excel® spreadsheet software to bring in data item information for a particular time period by referencing to any date within the corresponding time period.

```
=WON("PRICE",A17,"W-"&$C$16)
```
This page intentionally left blank.
VII. Additional Data Sources

(Not all Additional Data Sources are part of the base package and may require an entitlement.)

Thomson First Call® Earning Estimates in WONDA

Thomson First Call® earning estimates appear in three areas of the WONDA application:
- Thomson First Call® web pages
- Graphical Thomson First Call® data
- Thomson First Call® Custom Screen items

Thomson First Call® Web pages:

To access the Thomson First Call® data click on the First Call® icon.

This will open the Thomson First Call® window, which provides a variety of options. Each First Call data offering is accessed by clicking on the corresponding tab located along the top of the window.

FIRST CALL US Notes™ delivers real-time commingled broker research, morning meeting notes, intra-day research broadcasts and special equity notes from Wall Street’s top analysts with over one year of archived data.

FIRST CALL Research Direct™ offers institutional money managers electronic, real-time access to more than 1,000,000 commingled original full-text equity research reports originating from more than 300 leading brokerage firms worldwide with over one year of archived data. With FIRST CALL Research Direct™, clients access original research reports including all associated charts, graphs, color and artwork. E-mail alerts are available for both FIRST CALL Research Direct™ and FIRST CALL Notes™. This can be accessed under the Tools & Preferences Tab under the Alerts option. Any time the specified tickers come across the First Call® product(s) you have selected, First Call® e-mails you a report of the headlines including links to those documents. You can receive alerts 24 times a day, every hour on the hour.

Broker Detail Reports is a compilation of real time updated and historical data of earning estimates, recommendations and target price reports on a firm-by-firm basis.

To access First Call data, please contact your First Call representative directly. You may also contact Client Services at 800-419-6632 or support@williamoneil.com.
Consensus Reports provides Thomson First Call® quarterly and annual consensus earnings estimates, the number of brokers providing estimates for a particular period and the implied P/E ratios based on the consensus earnings estimates. In addition, year-over-year percentage changes and the consensus five-year growth rate are also provided. The default page is available to all users. Many additional reports are available for Thomson First Call® subscribers and are listed below.

Enhanced Thomson First Call® Earnings under Consensus Estimates
The Enhanced Thomson First Call® feature provides more detailed information for consensus earnings estimates and also provides detailed industry reports, index reports and other reports. In addition, these reports also integrate William O'Neil & Company's proprietary rankings for companies and industry groups. To access these additional reports, click on the desired link in the main Consensus Reports tab.

To access the Enhanced Thomson First Call® Consensus Estimates contact Client Services at 800-419-6632 or support@williamoneil.com.

• Consensus Reports - provides O'Neil Ratings and Rankings, Thomson First Call® consensus recommendations, expected report dates, consensus fiscal and calendar year estimate data, growth rates, 12-month target prices, company issued guidelines and other footnotes for estimates and actuals, estimate revisions and momentum, earnings surprises and broker coverage. The enhanced portion of this report includes Company footnotes.

• Industry Reports - provides detailed information on the industry of the company currently displayed. Reports include quarterly and annual consensus earnings estimates for the largest firms in that industry based on market capitalization, relative strength and earnings per share rank.

• Index Reports - provides consensus earnings estimates for the Dow 30 stocks as well as consensus earnings estimates on operating and reporting basis for the S&P 500 and S&P Industrial Indices.

• General Reports - provides consensus earnings for widely followed stocks, 12-month price targets, earnings due this week, analysts' highest rated stocks, earnings watch and several other general reports.

Broker Detail Reports - Provides Broker Coverage, Widely Followed Stocks and Contributing Firms. This data requires the Enhanced Thomson First Call® feature.

Tools & Preferences - This tab has several features:

Alerts allow subscribers to Thomson First Call Research Direct® and/or Thomson First Call Notes™ to receive email alerts using the Alerts option. Any time the specified tickers come across the Thomson First Call® product(s) you have selected, Thomson First Call® emails you a report of the headlines including links to those documents. You can receive alerts 24 times a day, every hour on the hour.

Advanced Search allows you to search for specific analysts, brokers within the Thomson First Call Research Direct™ and the Thomson First Call Notes™ product lines.

Preferences gives you options to set up your default Thomson First Call® page when you access the Thomson First Call® feature.
Entitlements allows the user to see what products they are entitled to see and what broker reports you can view for Thomson First Call US Notes™, Thomson First Call Research Direct® and Thomson First Call Broker Detail.

Graphical Thomson First Call® Features on WONDA

It is now possible to view Thomson First Call® data on WONDA graphs as well as in the Fundamental block and the Earnings block. In order to access these features

1. Click on drop down arrow next to the FC Icon.
2. Select Enable First Call.
3. Refresh the WONDA graph by clicking on the Daily, Weekly, Monthly or Intraday button.

Once the Thomson First Call® feature has been enabled, the Thomson First Call® earning estimates data will now appear in the Fundamental and Earnings block as indicated by the First Call® Earnings Data box that appears on the graph below. Also, clicking on the First Call® Earnings Data box will bring up the First Call® Consensus Estimates window.

Graphing Thomson First Call® Earning Estimates Revisions

First Call® Earning Estimates Revisions are available for the current fiscal quarter, current fiscal year and next fiscal year. Specific estimate revisions data are available in the First Call® Consensus Earnings Estimates window. In addition, revisions can be viewed graphically on Daily or Weekly graphs as follows.

1. Make sure that Enable First Call® is checked under the Settings menu.
2. Select Graphic Options under the Settings menu.
3. Click on the First Call® Settings.
4. Place a check mark in the box in front of each of the desired Estimate Revisions.
5. Select OK. Click on the First Call® Estimate Revisions from the FC Icon Arrow. Select a Daily or Weekly graph for the symbol of your choice.
6. The Estimate Revisions graph appears in the top portion of the WONDA® graph as shown on the following page.

**Note:** The first time the Thomson First Call® Earning Estimates Revisions from the FC Icon Arrow is selected, the First Call® Settings box shown above will automatically appear prompting the user to select the desired settings.

**Thomson First Call® Earnings Surprises Graphs and Projected Earnings Line**

Thomson First Call® Earning Estimates Surprises data is available on a per share or percentage basis. Specific amounts are available in the Thomson First Call® Consensus Earnings Estimates window. WONDA weekly graphs have been enhanced to incorporate First Call® Earnings Surprises on a quarterly basis. To view these features on a weekly WONDA graph:

1. Make sure that Enable First Call® is checked under the Settings menu.
2. Select Graphic Options under the Settings menu.
3. Click on the First Call® Settings.
4. Place a check mark in the box in front of “Display First Call® Earnings Surprises”.
5. Place a check in the box where the First Call® Earnings Surprise will display, either on the earnings line or at the top of the graph.
6. Select OK.
7. Enter a symbol and click the Weekly button.
The Thomson First Call® Earning Estimates Surprises are shown on the WONDA graph as a series of boxes containing the percentage and per share differences between actual and estimated earnings results. In addition, the WONDA earnings line will become an earnings line using actual and consensus earnings estimates provided by Thomson First Call®.

The Thomson First Call® Consensus Earning Estimates are available up to eight quarters. However, the default display is four quarters. To view the next four quarters, move the mouse to the end of the earnings line. When the arrow turns into a hand, click on it to include up to 8 quarters of Thomson First Call® Consensus Earning Estimates. You may also click on the FC Icon Arrow and select FC Est Earnings Line to extend the earnings line.

**Thomson First Call® Custom Screen Items**
(First Call Custom Screen Items are not part of the base WONDA package and require an entitlement.)

Users with the Thomson First Call® Entitlement may screen on such items as First Call® 12-Month Target Price, First Call® Consensus Recommendation, First Call® Fiscal Year Estimate, First Call® Quarterly Estimate, and First Call® Estimate Revisions using the WONDA Custom Screen feature.

For detailed information regarding Custom Screens, please refer to Section IV.

Enhanced First Call is not part of the base WONDA package and will require an entitlement. For information on pricing please contact Thomson Reuters at 800-782-5555.
Scrolling Headlines


Each of these features requires an entitlement. Contact Client Services at 800-419-6632 for more information.

To activate the Scrolling Headlines, click on the Scrolling Headlines Icon.

Create a new filter

To create a new filter, click the Filter menu and then click Create. This will open the Create Filter interface. Enter a Filter name in the Name field. Do not use any non-alpha numeric characters (other than a space, hyphen or underscore) when naming the filter.

The middle section of the interface allows clients to select the following filter criteria: Headline Source(s), Portfolio/List(s) and specific stock symbols. Headline Sources are listed in the format: Vendor – Product (e.g. FIRST CALL® – Research Direct). The portfolio/list(s) box will contain the names of all lists the client has in WONDA (Portfolios, Data Monitors, Alerts, etc.).

To select Headline Source(s), highlight the desired source and click the Insert button (located in the lower right-hand corner of the interface). Alternatively, the user may double-click on the desired Headline Source to add it to the filter. The Headline Source will then appear in the Selected Filter Parameters box at the bottom of the interface. Portfolio/List(s) may be added to the filter in the same manner.

To add specific stock symbols to the filter, type the symbol in the Symbol field and click the Insert button (or use the Enter key). To include stories where the selected symbol is not the primary focus of the story, place a check mark in the Include Secondary Stories box. A Symbol LookUp button is provided that allows users to locate a security by entering symbol or description. The description lookup searches for all company names that contain the characters entered. The symbol lookup searches for all symbols that contain the characters entered.

To save the filter, select the Save button at the bottom of the interface.

Users may delete specific filter parameters by highlighting them in the Selected Filter Parameters field and clicking the delete button. Use the Delete All button to delete all filter parameters.

The Save As button renames and saves an existing Scrolling Filter under a new name. The
Cancel button will close the Create Filter interface without saving changes.

The Help button opens the Help menu.

**Select Existing Filter**
To load an existing filter into the Scrolling Headlines window, select the Filter menu, choose the Select option and choose a filter from the list of saved filters. The selected filter will then load into the Scrolling Headlines window. To change the Scrolling Headlines window and display headlines from another filter, click Filter, choose the Select option and pick a filter from the list of saved filters.

**Edit Existing Filter**
To edit a Filter, select the Filter menu and choose the Edit option and choose the Filter to edit. This will open the Filter interface. Make the desired modifications and select Save or Save As (to create a new filter while leaving the existing filter unchanged).

**Delete Existing Filter**
To delete a filter, click Filter, then Delete and select a filter from the list of saved filters.

**Display Settings Menu**
This feature allows clients to set the display options for new and saved filters.

All changes to the display settings are visible in the preview box to assist clients in determining optimal readability. Clicking on a headline source in the PREVIEW box will automatically change the font, font style and font size highlighting to reflect the current settings.

The Use Default Options Settings button allows clients to reset changes back to the original system defaults.

**Font**
The Font tab in the Display Settings menu allows clients to adjust the Font Type, Font Style and Font Size for each headline source.

Click the Font Tab then select the Headline Source, choose the Font Type, Font Style and Font Size. Click the Apply button to save the settings. Click the OK button to save the settings and return to the scrolling headline screen. Click the Cancel button to cancel any changes made to settings.

**Color**
The Color tab in the Display Settings Menu allows clients to adjust background and foreground colors for each headline source.

Click the Color tab then select the Headline Source, choose the Background Color and Foreground Color desired. Click the Apply button to save the settings. Click the OK button to save the settings and return to the Scrolling Headline screen. Click the Cancel button to cancel the any changes made to these settings.

**Options**
The Options tab in the Display Settings menu allows the client to change the scrolling direction, set the default number of headlines to display in the window (200 maximum), turn on/off the Top Menu, Column Headings, Horizontal and Vertical Grid Lines and allows clients to auto-size the row height when setting row parameters such as font type, style and size. It also allows the client to access a WONDA graph or a report when using the mouse to double-click a headline.
Click the Options tab then select the Scrolling direction, choose the Number of Headlines and activate/deactivate the Top Menu, Column Headings, Horizontal and Vertical Grid Lines as desired. Also, click the option to draw a graph or view the default report when double-clicking with the left mouse button. Holding the CTRL key and double-clicking the headline will perform the opposite function of the defaulted activity. Click the Apply button to save the settings. Click the OK button to save the settings and return to the Scrolling Headline screen. Click the Cancel button to cancel the any changes made to these settings.

Pause Scrolling/Resume Scrolling Menu

Pause Scrolling allows clients to pause the scrolling headlines while using the space bar to scroll through a list and draw graphs of existing headlines.

Resume Scrolling allows clients to reactivate the scrolling headline feature.

If for any reason connection to the Internet is lost, the scrolling icon will turn red. Once connectivity is recovered, the scrolling icon will turn green once again.

Print Menu

Click Print from the Print menu to print the current Scrolling Filter headlines. Then select the print parameters and click the OK button to print.

Click the Cancel button to cancel the print job.

Definitions of Codes listed Under the Source Column

<table>
<thead>
<tr>
<th>Scrolling Headline Code</th>
<th>Headline Source</th>
<th>Windows displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>DJNW</td>
<td>Dow Jones News Sources Web Page</td>
<td>Dow Jone News Story</td>
</tr>
<tr>
<td>FCNT</td>
<td>First Call® -US Notes</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCRD</td>
<td>PDF First Call® - Research Direct</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCBE</td>
<td>First Call® -Broker Detail Estimates Changes</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCBT</td>
<td>First Call® –Broker Detail Target Price Changes</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCBR</td>
<td>First Call® –Broker Detail Recommendation Changes</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCCE</td>
<td>First Call® Consensus Estimate Changes</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCCR</td>
<td>First Call® –Consensus Recommendations Changes</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCCT</td>
<td>First Call® -Consensus Target Price Changes</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCGL</td>
<td>First Call® -Company Issued Guidelines</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>FCNA</td>
<td>First Call® -US Notes Alerts</td>
<td>First Call® Webpage</td>
</tr>
<tr>
<td>WOLR</td>
<td>William O'Neil -New Leaders and Laggards Review</td>
<td>Ticker's Graph</td>
</tr>
<tr>
<td>WOLC</td>
<td>William O'Neil -New Leaders and Laggards Large Cap Review</td>
<td>Ticker's Graph</td>
</tr>
</tbody>
</table>
Thomson Equity Strategies

New insider data and estimate revision model data is available in WONDA from Thomson Equity Strategies (TES). The data can be accessed using the TES icon.

Two different entitlements are available: Web access and Insider Trading Model.

Web Access
This feature is a drill down summary of the insider transactions as well as access to Thomson Equity Strategies website data. To display data, either click directly on the TES icon or click on an insider transaction on the weekly graph. Once inside the transaction summary window, you may click on the Thomson icon or select the insider summary located on a weekly graph.

Thomson Equity Strategies (TES) Models
To access the TES models click on the drop down arrow next to the TES button. Next, place a check mark beside the Graph Insider Trading Model option and/or the Graph Estimate Revision Model by clicking on it.
Section VII: Additional Data Sources

Place a check mark beside the Flag Insider Trading. The flags will show up on the Relative Strength (RS) line. The Insider Trading Flag displays above the RS line and the Estimate Revision displays below the RS line. The color of the flags corresponds to the color of the lines on the graph.

To get an overview of how the models are constructed click on the Thomson Equity Strategies link, click on the TES icon or directly on the flags.

To change the settings on how the data is displayed click on Settings and select Graphic Options. There is an option called Thomson Equity Settings. Open the menu by clicking on the plus sign next the Thomson Equity Settings and select the Insider Trading Model or Ranking Flags. For the graphs and flags you can change the default color, which data to view (Revised and/or Decayed), the shading range/color and how many flags to display.

Thomson Equity Strategies data is not a part of the base WONDA package and requires an entitlement. For more information please contact Client Services at 800-419-6632 or support@williamoneil.com.
Enhanced EDGAR by WONDA

This feature provides WONDA clients an improved look at original SEC EDGAR filings, which are often difficult to read, poorly formatted and can take a long time to download and view. William O’Neil + Company’s new web-based format dramatically improves the layout and readability of the filings.

Accessing SEC Filings for an Individual Stock

1. Bring up a Daily, Weekly, Monthly, or Intraday graph for the desired company.

2. Click on the Enhanced EDGAR Files Icon.

This will launch the Enhanced EDGAR window (shown below). The SEC documents are separated by type of filing and sorted by date in descending order. To view a particular filing, click on the Filing Links, which appear in blue font.
The selected document will now appear as shown below. To access the Table of Contents, click on the hyperlink in the document’s top left corner. Major sections and subsections will be listed in the left column. To move directly to a particular section, simply click on the heading in the table of contents or subsections. The actual text of the document will be displayed in the inner frame. To print the document, click on the printer icon located in the upper left-hand corner of the Stock Data Toolbar.

To view the complete titles of the major sections and subsections, move the scrollbar located in the bottom left corner from left to the right.

To return to the list of filings for the current stock, simply click on the Back to Filings tab at the top of the window.
Using the Enhanced EDGAR Search Function

Once the Enhanced EDGAR® window is open, searches can be performed by Company Name, Ticker Symbol, or CIK (Central Index Key) Code. Searches are accomplished by setting the search criteria in the drop down menus. To search for a company by name:

1. Select Company Name from the first drop down menu.
2. Enter all or the partial name in the Search field.
3. Click on the Search button.

The search results appear in the lower half of the screen.
Russell Index Components

The Russell Index Components are not part of the base WONDA package and will require an entitlement. The Russell Indices are available for all WONDA clients. If you are a current Russell Index client, please contact Russell directly at 253-439-2444 and speak to your client account manager or sales executive. If you are not a Russell Index client, please contact Client Services at (800) 419-6632 for more information.

The following Russell Index Components are available as 4 separate entitlements in WONDA: Russell Family (includes the Russell 2000® Index), Russell 3000E® Index, Russell Top 50® Index, and Russell Microcap® Index. This entitlement provides current Russell clients access to the components of the Russell indices in tabular form. To access the components, click on the Market button, select the Market Index Components option, click on the preferred Russell Index. Custom Screens may also be used to filter on the components of each index.
Section VII: Additional Data Sources

All Russell indices including both price-weighted and total return indices are available graphically to all WONDA users. To access these graphs, click on the Market button and select the Russell Indices option. A window will appear displaying all indices and the index values plus we’ve also added the percent change for various time periods as a reference.

Russell Index clients may also use the screening feature to filter out stocks or create data reports. Data Dictionary Items WONDA Users entitled to this feature can incorporate the Russell Index components into their custom screens and custom data blocks.

For a complete list of the Russell data items available in custom screens and custom data blocks, please refer to Section VII.
Dow Jones News Service®

Streaming news reports are accessible on WONDA through the Dow Jones News Service®. To access Dow Jones News story on a particular stock:

1. Pull up a Daily, Weekly, Monthly or Intraday graph
2. Click on the Dow Jones icon.

The Dow Jones icon will turn red for the latest story within 24 hours; blue for last released stories outside of 24 hours. Additionally, a green Dow Jones icon will be green if a scrolling headline filter was created using Dow Jones News as a headline source. This icon launches the Dow Jones News Service® webpage as shown below. Any news stories, including secondary stories, for the desired stock will appear with a date and time. To view the news item, simply click on the Story Link.
Section VII: Additional Data Sources

To view stories for different companies, type a ticker into the Dow Jones News Service® Symbol field and click Go. To Search on a keyword, type the word into the Keyword field and click Go. Other filter for finding news stories include:

- Hot News on a specific company
- Topics including Calendar, Industry, or General stories
- Advanced Search on stocks, keywords, or WONDA portfolios on specific time periods

Dow Jones News Service® is not part of the base WONDA package and will require an entitlement. If you are interested in receiving the Dow Jones entitlement, please contact your Dow Jones Account Representative directly or contact Client Services at 800-419-6632 for more information.
This Page left intentionally blank.